# Table of Contents

1 – The FRA32M and FRA2 module .......................................................... 4  
2 – Hardware setup .................................................................................. 5  
  2.1 – FRA32M ....................................................................................... 5  
  2.2 – FRA2 .......................................................................................... 7  
3 – The FRA manual control .................................................................... 13  
4 – The FRA measurement commands .................................................... 22  
  4.1 – FRA measurement parameters ....................................................... 23  
    4.1.1 – Frequency scan ..................................................................... 25  
    4.1.2 – Sampler ................................................................................ 26  
    4.1.3 – Options ................................................................................ 30  
    4.1.4 – Plots ..................................................................................... 32  
    4.1.5 – Summary ............................................................................. 33  
    4.1.6 – Manual modification of parameters of the scan ................. 35  
    4.1.7 – Adding additional frequencies to the scan ...................... 36  
    4.1.8 – Sorting the frequencies in the frequency scan .............. 37  
    4.1.9 – Resetting the changes ......................................................... 38  
    4.1.10 – Multi sine measurements ................................................ 39  
5 – Impedance measurements on the dummy cell .................................... 44  
  5.1 – FRA impedance tutorial #1 – Single sine frequency scan ............. 44  
  5.2 – FRA impedance tutorial #2 – Multi sine frequency scan ............ 47  
  5.3 – FRA impedance tutorial #3 – Time domain data ....................... 48  
  5.4 – FRA impedance tutorial #4 – Real time data analysis .......... 51  
  5.5 – FRA impedance tutorial #5 – DC measurements in frequency scan .. 53  
  5.6 – FRA impedance tutorial #6 – Time scan .................................. 55  
6 – Impedance data analysis tools ............................................................. 57  
  6.1 – Electrochemical circle fit ............................................................. 58  
  6.2 – Fit and Simulation ....................................................................... 63  
    6.2.1 – Generating an equivalent circuit from a CDC string ........ 68  
    6.2.2 – Loading a pre-defined equivalent circuit from a list .......... 70  
    6.2.3 – Drawing the equivalent circuit using individual circuit elements 72  
    6.2.4 – Parameter editing ................................................................. 79  
    6.2.5 – Running the calculation ......................................................... 83  
    6.2.6 – Dynamic command parameters ......................................... 90  
    6.2.7 – Displaying the results ............................................................... 91  
    6.2.8 – Advanced editing ................................................................. 94  
    6.2.9 – Saving circuits ................................................................. 96  
    6.2.10 – Exporting and importing circuits .................................... 99  
    6.2.11 – Simulating experimental data ............................................ 99  
    6.2.12 – Pseudo capacitance determination ................................. 100  
  6.3 – Kronig-Kramers test .................................................................... 101  
  6.4 – Include all FRA data ................................................................. 106  
  6.5 – Potential scan FRA data ............................................................ 110  
  6.6 – Export to ZView ......................................................................... 118  
7 – Advanced FRA measurements ............................................................. 119  
  7.1 – Single point measurements ...................................................... 119
1 – The FRA32M and FRA2 module

Electrochemical impedance spectroscopy measurements can be performed with the Autolab instruments in combination with the FRA32M or FRA2 module.

In the rest of this tutorial, both the FRA32M and the FRA2 modules will be referred to as FRA (Frequency Response Analyzer) module, except when specifically mentioned as FRA32M or FRA2.

In a typical electrochemical impedance measurement, the FRA module generates a sine wave with a user-defined frequency and a small amplitude. This signal is superimposed on the applied DC potential or current on the cell. The AC voltage and current components are analyzed by the two FRA channels and the transfer function, the total impedance $Z$, is calculated, together with the phase angle shift and the real and imaginary components of the total impedance.

The total impedance, $Z$ is given by:

$$Z = Z' - j \cdot Z''$$

Where $Z'$ and $Z''$ are the real and imaginary components of the impedance, respectively.

The phase angle shift is given by:

$$-\phi = \tan^{-1}\left(\frac{-Z''}{Z'}\right)$$

Scope of the tutorial

The aim of this tutorial is to explain how to perform electrochemical impedance spectroscopy measurements, with the dedicated FRA32M or FRA2 module. The data acquisition parameters are explained and a number of examples are provided. Data analysis, an important aspect of impedance measurements is also explored.

---

1 By default, the $Z = Z' - j \cdot Z''$ convention is used for all impedance measurements performed in Nova. It is possible to use the $Z = Z' + jZ''$ convention if necessary. More information is provided in Section 4.2 of this document.
2 – Hardware setup

In order to perform electrochemical impedance spectroscopy measurements the FRA module must be installed and the hardware setup in NOVA must be setup accordingly.

2.1 – FRA32M

When the FRA32M module is used, the FRA32M checkbox must be selected in the hardware setup (see Figure 1).

![Hardware setup](image)

Figure 1 – Adjusting the Hardware setup (FRA32M)

The FRA32M also requires the values of the $C_1$ and $C_2$ coefficients to be specified in the hardware setup. Click the main module used in combination with the FRA32M module. The $C_1$ and $C_2$ values will be displayed in the frame on the right-hand side of the hardware setup window (see Figure 2).

---

2 The FRA32M is automatically detected upon connection to the computer. The hardware setup self-adjusts but it is advised to verify the settings.
The C1 and C2 values need to be specified manually in the Hardware setup window. If the values of C1 and/or C2 are not specified for the connected instrument, a warning will be displayed in the User log after the initialization process (see Figure 3).

The values of C1 and C2 are determined experimentally. Please refer to the Getting started manual or the Module test with NOVA document, available from the Help menu, for more information or contact your Autolab distributor.

If the values of C1 and/or C2 are not specified for the connected instrument, a warning will be displayed in the User log after the initialization process (see Figure 3).

<table>
<thead>
<tr>
<th>User log message</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1 and C2 are not specified for the selected PGSTAT (AUT341 48)</td>
<td>2:10:20 PM</td>
</tr>
<tr>
<td>Autolab/USB connected (AUT34148)</td>
<td>2:10:21 PM</td>
</tr>
</tbody>
</table>

Figure 2 – The C1 and C2 values need to be specified manually in the Hardware setup window

Figure 3 – A warning is displayed when the values of C1 and C2 are not properly specified
2.2 – FRA2

When the FRA2 module is used, the FRA2 checkbox must be selected in the hardware setup\(^3\) (see Figure 4).

![Hardware setup](image)

Figure 4 – Adjusting the Hardware setup (FRA2)

Depending on the type of FRA2 module, the **FRA2 offset DAC range** needs to be adjusted to the correct value. FRA2 modules labeled FRA2.V10 (see Figure 5) on the front panel must be set to **10V offset DAC range**\(^4\). FRA2 modules labeled FRA2 (see Figure 5) on the front panel must be set to **5V**\(^5\) (see Figure 4).

**Note**

Some FRA2 modules, originally fitted with a **5V** range have been modified to the **10V** range for special applications\(^5\).

---

\(^3\) The FRA2 is not automatically detected upon connection to the computer.

\(^4\) This does not apply to FRA2 modules installed in the µAutolab type III, for which this field is greyed out.

\(^5\) Please contact your Autolab distributor for more information.
Each FRA2 module is calibrated in order to operate correctly inside the Autolab instrument. Before the FRA2 can be used for impedance measurements, the calibration file must be added to the hardware configuration in NOVA.

**Warning**

For the FRA2 module make sure that the **FRA2 offset DAC range** property is set properly in the hardware setup. Failure to set this value properly may result in faulty data at frequencies of **25 Hz** and lower (refer to front panel labels of the FRA2 module on the instrument).

Each FRA2 module is calibrated in order to operate correctly inside the Autolab instrument. Before the FRA2 can be used for impedance measurements, the calibration file must be added to the hardware configuration in NOVA.

**Note**

When NOVA is installed from the CD delivered with a new instrument, the FRA2 calibration file is copied onto the computer automatically, if required. This also applies when upgrading an existing NOVA version installed on the computer.

If the FRA2 calibration data is missing, a **warning** message will be displayed in the User log after starting NOVA (see Figure 6).
In this case, the FRA2 calibration file must be imported manually. This file (*fra2cal.ini*) can be found in two different locations:

- If the GPES/FRA software is already installed on the computer, the *fra2cal.ini* file can be found in the C:\Autolab folder.
- Alternatively, the *fra2cal.ini* file can be found on the GPES/FRA 4.9 installation CD matching the serial number of the instrument\(^6\), in the D:\install\disk1 folder.

**Warning**

If the *fra2cal.ini* file cannot be located, contact your local distributor (serial number of the instrument required).

To import the FRA2 calibration file, select the Hardware setup from the Tools menu. In the Hardware setup window, click the *Import FRA2 Calibration...* button and locate the file *fra2cal.ini* (see Figure 7).

---

\(^6\) The serial number of the instrument can be found on label(s) attached to the cell cables or on the back panel of the instrument.
Figure 7 – Importing the FRA2 calibration file (1/2)
Click the button to load the file (see Figure 8).

![Image of Open dialog box]

**Figure 8** – Importing the FRA2 calibration file (2/2)

You will be prompted to define the type of instrument for which the *fra2cal.ini* file is intended (see Figure 9).

![Image of calibration factors selection]

**Figure 9** – Selecting the instrument type for the *fra2cal.ini* file
NOVA Impedance spectroscopy tutorial

Click the OK button to confirm the selection of the instrument\(^7\) and the OK button in the Nova options window to complete the installation of the FRA2 module calibration file.

**Note**

If a calibration file was previously imported in Nova, an overwrite warning will be displayed. Click the Yes button to confirm the replacement of the file (see Figure 10).

![Image of Import FRA2 Calibration dialog box](image1.png)

**Figure 10 – Replacement of a previously defined fra2cal.ini file**

**Note**

When the fra2cal.ini file is imported, the serial number of the instrument is verified. If it does not match the serial number indicated in the fra2cal.ini file, an error message will be displayed (see Figure 11). The fra2cal.ini is not imported in this case.

![Image of Incorrect FRA2 calibration file dialog box](image2.png)

**Figure 11 – An error message is displayed when the fra2cal.ini file does not match the connected instrument**

\(^7\) See the front panel of the instrument.
3 – The FRA manual control

The Autolab display can be used to measure the impedance of the electrochemical cell manually. This is convenient if the cell impedance must be determined quickly, without running a complete procedure.

To use the FRA manual control select the FRA manual control option from the View menu to add it to the Autolab display (see Figure 12).

The Autolab display window will appear, showing the DC values of potential and current as well as other instrumental settings. An additional FRA manual control panel will be displayed in the lower part of the Autolab display (see Figure 13).
Figure 13 – The Autolab display shows the DC values of the potential and current as well as other instrumental settings and the FRA manual control panel.

Note

The use of the Autolab display is described in detail in the Nova User Manual (see Chapter 3).
The FRA manual control panel will be added to the Autolab display. This panel can be used to define the following settings:

- **Frequency**: the frequency to use in the measurement (single sine) or the base frequency to use in the measurement (multi sine).\(^8\)
- **Amplitude**: the amplitude to be used in the measurement, specified as TOP value.
- **Mode**: the inputs used for the impedance measurement (internal – through the PGSTAT or external – through the SMB/BNC inputs located on the front panel of the instrument).\(^9\)
- **Wave type**: toggles between single sine or multi sine measurements (5 or 15 sines). For multi sine measurements, the base frequency displayed in the FRA manual control frame is the fundamental frequency.
- **Integration time (s)**: the time, in seconds, used to analyze the impedance of the cell.
- **Minimum number of cycles to integrate**: the minimum required periods of the AC signal to analyze. For low frequency measurements, this setting will override the integration time.\(^10\) For multi sine measurements, this setting is defined relative to the period of the fundamental frequency.

To perform a FRA measurement using the FRA manual control panel, click the amplitude label on the right-hand side (see Figure 14).

---

\(^8\) More information on multisine measurements is provided in the rest of the tutorial.

\(^9\) The external FRA inputs are not available on the µAutolab III.

\(^10\) If \([(1/\text{frequency}) \times \text{number of cycles to integrate}] \) is larger than the integration time, the duration of the measurement will be defined by the minimum number of cycles to integrate.
Figure 14 – Click the amplitude label in the FRA manual control panel to edit the amplitude

Clicking the **amplitude** label allows you to specify the amplitude of the AC modulation to be used in the measurement. Press Enter to validate value.

**Note**

The amplitude is defined as TOP amplitude. This value is equal to the RMS amplitude multiplied by $\sqrt{2}$.

Click the **frequency** label on the left hand side of the panel to define the frequency to be used in the measurement, in Hz, as shown in Figure 15 and press Enter to validate the value.
Figure 15 – Click the frequency label in the FRA manual control panel to edit the frequency

Adjust the Mode, Wave type, Integration time and Minimum number of cycles to integrate, if necessary, and press the FRA ON label on the FRA manual control panel to start the measurement (see Figure 16).
NOVA Impedance spectroscopy tutorial

**Figure 16** – Press the FRA ON label to start the impedance measurement

---

**Note**

If the Mode is set to Internal, the PGSTAT inputs will be used for the impedance measurement. Do not forget to switch the cell on by clicking the **CELL ON** label on the Autolab manual control located above the FRA manual control panel. If the Mode is set to external, the two analog inputs located on the front panel will be used instead (the transfer function is assumed to be Channel X / Channel Y).

---

**Note**

The noise gauges may indicate high noise levels in the Autolab display (see Figure 16). These gauges should be disregarded when the FRA is ON.
The impedance measurement will be repeated using the provided settings until the user switches off the FRA manual control by clicking the FRA ON label again.

After each measurement, the values of the following parameters will be updated at the bottom of the FRA manual control panel (see Figure 16):

- \( E(\text{DC}) \) and \( E(\text{AC}) \): the measured DC and AC potential, in volts.
- \( i(\text{DC}) \) and \( i(\text{AC}) \): the measured DC and AC current, in amperes.
- \( \% E \) and \( \% i \): the experimental resolution of the two on-board A/D converters. For accurate results, the resolution should be as high as possible\(^{11}\).
- \( \text{Freq.}, Z, \text{-Phase}, Z', -Z'' \): the frequency, total impedance, -phase angle, real and imaginary component, respectively.

During the measurements, the elapsed integration time is also displayed in the FRA manual control panel (see Figure 16).

The FRA manual control does not automatically adjust the settings of the Autolab PGSTAT. When measuring in combination with the Autolab, the current range must be selected carefully. If the active current range is too low, a current overload can be observed (see Figure 17). On the other hand, if the active current range is too high, the measured AC current resolution will be too low.

\(^{11}\) During the measurement, the gain factors of both A/D converters are continuously adjusted in order to maximize the resolution.
While the instrument is measuring, it is possible to change the frequency or the amplitude. This can be done by clicking the respective labels in the FRA manual control panel, as described previously. To edit the other settings, the impedance analyzer must first be switched off by clicking the FRA ON label in the panel.

**Note**

For multi sine measurements, the values of each individual frequency will be shown in the FRA manual control (see Figure 18).
Figure 18 – During multi sine measurement, the measured data for every frequency component is listed in the FRA manual control panel.

Note

The panels in the Autolab manual window can be collapsed by clicking the button located in the left corner of each panel.
NOVA Impedance spectroscopy tutorial

4 – The FRA measurement commands

Impedance spectra can be recorded using the \textit{FRA measurement} commands available in the Measurement – impedance group (see Figure 19).

<table>
<thead>
<tr>
<th>Commands</th>
<th>Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Favorite commands</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td></td>
</tr>
<tr>
<td>Metrohm devices</td>
<td></td>
</tr>
<tr>
<td>External devices</td>
<td></td>
</tr>
<tr>
<td>Measurement - general</td>
<td></td>
</tr>
<tr>
<td>Measurement - cyclic and linear sweep voltammetry</td>
<td></td>
</tr>
<tr>
<td>Measurement - voltammetric analysis</td>
<td></td>
</tr>
<tr>
<td>Measurement - chrono methods</td>
<td></td>
</tr>
<tr>
<td>\textbf{Measurement - impedance}</td>
<td></td>
</tr>
<tr>
<td>- FRA measurement potentiostatic</td>
<td></td>
</tr>
<tr>
<td>- FRA measurement galvanostatic</td>
<td></td>
</tr>
<tr>
<td>- FRA measurement external</td>
<td></td>
</tr>
<tr>
<td>- FRA frequency scan</td>
<td></td>
</tr>
<tr>
<td>- FRA single frequency</td>
<td></td>
</tr>
<tr>
<td>Data handling</td>
<td></td>
</tr>
<tr>
<td>Analysis - general</td>
<td></td>
</tr>
<tr>
<td>Analysis - baseline correction</td>
<td></td>
</tr>
<tr>
<td>Analysis - corrosion</td>
<td></td>
</tr>
<tr>
<td>Analysis - impedance</td>
<td></td>
</tr>
<tr>
<td>Plots - general</td>
<td></td>
</tr>
<tr>
<td>Plots - impedance</td>
<td></td>
</tr>
<tr>
<td>My commands</td>
<td></td>
</tr>
</tbody>
</table>

\textbf{Figure 19 – The Measurement – impedance group of commands}

The commands are tagged into three different profile levels (see Table 1).

\begin{table}[h]
\begin{tabular}{|c|c|}
\hline
\textbf{Basic} & \textbf{Advanced} \\
\hline
\textbf{Measurement - impedance} & \textbf{Measurement - impedance} \\
- FRA measurement potentiostatic & - FRA measurement potentiostatic \\
- FRA measurement galvanostatic & - FRA measurement galvanostatic \\
- FRA frequency scan & - FRA frequency scan \\
- FRA single frequency & - FRA single frequency \\
\hline
\end{tabular}
\end{table}

\textbf{Table 1 – The Measurement – impedance commands are tagged into two different profile levels}
Up to five different FRA measurement commands are available in this group:

- **FRA measurement potentiostatic**: used to perform a full frequency scan in potentiostatic conditions
- **FRA measurement galvanostatic**: used to perform a full frequency scan in galvanostatic conditions
- **FRA measurement external**: used to perform a full frequency scan using the external inputs of the FRA module
- **FRA frequency scan**: used to create a repetition loop for impedance spectra
- **FRA single frequency**: used to measure the impedance of the cell at a single frequency

The first three commands can be used to perform a complete frequency scan. The potentiostatic and galvanostatic FRA measurement commands only differ in the scope of the electrochemical control used (potentiostat or galvanostat). The use of these commands is explained in the next section, using the potentiostatic command as an example. The FRA measurement external command is a special command that involves the use of the external inputs of the FRA2 or FRA32M module. The use of this command is covered in Section 7.2 of this document.

The other two commands are reserved for special applications and are not covered by this tutorial.

### 4.1 – FRA measurement parameters

The FRA measurement commands provide a dedicated editor through which all the parameters required for a frequency scan can be defined. To open this editor, click the button located next to the command in the procedure editor (see Figure 20).
Figure 20 – Opening the parameter editor for the FRA measurement command

The FRA editor window will be displayed (see Figure 21).

Figure 21 – The FRA editor window

Depending on the measurement command, four or more sections will be displayed in the frame on the left-hand side of the FRA editor (see Figure 21).
4.1.1 – Frequency scan

The Frequency scan section of the FRA editor window is used to specify the frequency scan parameters using in the measurement (see Figure 22).

![FRA editor window with Frequency scan parameters](image)

**Figure 22 – The Frequency scan parameters**

The following parameters are defined in this section:

- **First applied frequency**: the first frequency of the scan, in Hz.
- **Last applied frequency**: the last frequency of the scan, in Hz.
- **Number of frequencies (per decade)**: the number of frequencies (or frequencies per decade) in the scan.
- **Frequency step**: the distribution of frequencies used in the scan. For impedance spectroscopy measurements, the logarithmic distribution or frequencies per decade are usually the most suitable choice.
- **Amplitude**: the value of the applied amplitude, specified as RMS or TOP value. The TOP amplitude is equal to the RMS amplitude multiplied by $\sqrt{2}$.
- **Wave type**: the modulation type applied during the scan (single sine or multi sine).

**Note**

More information on multi sine measurements is provided in Section 4.1.10 of this document.
4.1.2 – Sampler

The acquisition parameters used during the frequency scan are specified in the Sample section of the FRA editor. This section is split into two parts, Basic and Advanced (see Figure 23).

**Figure 23 – The Basic Sampler parameters**

The following parameters are defined in the Basic editor:

- **Maximum integration time (0.125 s):** the longest time, in seconds, during which the AC response of the cell is recorded for data analysis. Long integration time values increase the duration of the frequency scan but improve the signal to noise ratio.

- **Minimum integration cycles (1):** defines the minimum cycles of the AC response to record for data analysis (this value overrides the previous parameter at low frequencies). The minimum value is one cycle and the maximum number is 16. Integrating over a large number of cycles increases
the duration of the frequency scan but improves the signal to noise ratio. This value must be an integer.

The **Integration time** and **Minimum number of cycles to integrate** define the duration of the data acquisition segment for each **FRA single frequency command**. These two parameters are competing against one another and depending on the frequency of the applied signal: the measurement duration will be defined by one of these two parameters:

- If the **Frequency** is larger than \(1/\text{Integration time}\), the acquisition time will be defined by the **Integration time** parameter.
- If the **Frequency** is smaller than \(1/\text{Integration time}\), the acquisition time will be defined by the **Minimum number of cycles to integrate** parameter.

Furthermore, it is possible to specify if additional signals must be sampled or calculated during the measurement. The following settings are available:

- **Sample time domain**: if this option is active, the time domain information will be sampled and stored for the potential and the current. The time domain information consists of the raw potential and current sine waves. This information can be used to build a Lissajous plot, or to evaluate the signal to noise ratio and to verify the linearity of the cell response. The **Time domain**, **Potential (AC)** and **Current (AC)** and **Potential resolution** and **Current resolution** signals are added to the data for each individual frequency when this option is on.

- **Sample frequency domain**: if this option is active, the frequency domain information will be sampled and stored for the potential and the current. The frequency domain information consists of the calculated FFT results obtained from the measured time domain. The frequency domain information can be used to evaluate the measured frequency contributions. The **Frequency domain**, **Potential frequency domain** and **Current frequency domain** signals are added to the data for each individual frequency when this option is on.

- **Sample DC**: if this option is active, the DC components for both the potential and current will be sampled and stored alongside the impedance data. The **Potential (DC)** and **Current (DC)** signals are added to the data for each individual frequency when this option is checked. This option is active by default.

- **Calculate admittance**: if this option is active, the admittance values will be calculated during the measurement \(Y', -Y''\).

Additional settings can be specified in the **Advanced** editor. To toggle the display of the parameter, click the  button next to the Advanced label in the editor (see Figure 24).
The Advanced settings are predefined to an optimal value for most measurements. Please read the following section of the manual carefully before adjusting these settings.

- **Re-jIm or Re+jIm radio button**: this setting defines how the impedance is expressed in terms of its real (Re, or Z') and imaginary (Im or Z") components. By default, the Re-jIm convention is used. Using this toggle it is possible to acquire impedance data using the alternative convention\(^{12}\).

- **Lowest bandwidth**: defines the lowest bandwidth setting used by the Autolab during the measurement (High stability, High speed and Ultra high speed). In High stability, the bandwidth will automatically be set to High stability for frequencies below 10 kHz and to High speed for frequencies below 100 kHz. The Ultra high speed mode is used for frequencies above 100 kHz. When this parameter is set to High speed, the High stability setting is not used. When this parameter is set to Ultra high speed, only this bandwidth setting is used. High stability is set by default and is recommended for most measurements\(^{13}\).

---

\(^{12}\) When the Re+jIm convention is used, the impedance analysis tools provided in Nova cannot be used since these tools assume that the Re-jIm convention is used. In this case, data analysis should be performed using a third party application, like ZView.

\(^{13}\) Please refer to the Getting Started manual for more information on the Autolab bandwidth settings.
• **Number of cycles to reach steady state**: the number of cycles to apply in between two consecutive frequencies before resuming data acquisition (0 – 30000 cycles).

• **Maximum time to reach steady state (s)**: the maximum amount of time to wait between two consecutive frequencies before resuming data acquisition (this value overrides the previous setting at low frequencies). The maximum value is 30000 s.

• **With a minimum fraction of a cycle**: defines the minimal fraction of a cycle to wait before the response can be recorded (overrides the previous setting at very low frequencies). This value can be set between 0 and 1.

The **Number of cycles to reach steady state, Maximum time to reach steady state, with a minimum fraction of a cycle** parameters define the duration of the stabilization segment between two consecutive frequencies. These parameters are competing against one another, and depending on the frequency of the applied signal, the timing will be defined by one of these three parameters:

- If the \( \frac{\text{Number of cycles to reach steady state}}{\text{Frequency}} \) is smaller than \( \text{Maximum time to reach steady state} \), the settling time will be defined by the **Number of cycles to reach steady state** parameter.
- If the \( \frac{\text{Number of cycles to reach steady state}}{\text{Frequency}} \) is larger than \( \text{Maximum time to reach steady state} \), the settling time will be defined by the **Maximum time to reach steady state** parameter.
- For very low frequencies, if \( \frac{1}{\text{Frequency}} \) is larger than the **Maximum time to reach steady state**, the settling time will be defined by the **With the minimum fraction of a cycle** parameter.

Figure 25 provides a schematic overview of the five timing parameters. At low frequency, the integration time is overruled by the **minimum number of cycles to integrate**. At low frequency, the number of cycles to reach steady state parameter is overruled by the **maximum time to reach steady state** parameter or the by the **with a minimum fraction of cycle** parameter, in a similar way.
4.1.3 – Options

The options used during the frequency scan are specified in the Options section of the FRA editor (see Figure 26).

![Figure 26 – The Options parameters](image)

**Note**

The Options section is not available in galvanostatic measurements.
The following parameters can be defined in the Options section:

- **Automatic current ranging**: defines if the Automatic current ranging option should be used during the frequency scan. When this option is used, the highest and lowest current range can be specified.
- **Highest current range**: the highest current range used in the options.
- **Lowest current range**: the lowest current range used in the options.

**Note**

The Automatic current ranging option is the only option that can be used in a FRA measurement. The Autolab control and Cutoff options cannot be used, and the Integrator options are not relevant for FRA measurements.

The automatic current ranging parameters are defined using the provided drop-down lists (see Figure 27).

**Figure 27 – The Automatic current ranging settings are defined using drop-down lists**

**Note**

The measurement duration may increase when the Automatic current ranging options is used.
4.1.4 – Plots

The Plots section of the FRA editor window is used to specify which plots should be generated during the measurement (see Figure 28).

![FRA editor window](image)

Figure 28 – The Plot parameters

<table>
<thead>
<tr>
<th>Plots</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nyquist impedance</td>
<td>1 2 3 4</td>
</tr>
<tr>
<td>Nyquist admittance</td>
<td>1 2 3 4</td>
</tr>
<tr>
<td>Bode</td>
<td>1 2 3 4</td>
</tr>
<tr>
<td>AC vs t</td>
<td>1 2 3 4</td>
</tr>
<tr>
<td>Resolution vs t</td>
<td>1 2 3 4</td>
</tr>
<tr>
<td>Lissajous</td>
<td>1 2 3 4</td>
</tr>
</tbody>
</table>

Note

The available plots depend on the parameters specified in the Sampler section.

The following plots are available (if the Sampler parameters are adjusted accordingly):

- **Nyquist impedance**: plots the measured $-Z''$ values versus the measured $Z'$ values, using isometric axes.
- **Nyquist admittance**: plots the calculated $-Y''$ values versus the calculated $Y'$ values, using isometric axes.
- **Bode**: plots the phase (in opposed values) and the logarithm of the measured impedance ($Z$), versus the logarithm of the frequency.
- **AC vs t**: plots the raw sinewave amplitudes for the potential and the current signals versus the time.
- **Resolution vs t**: plots the instrumental resolution for the measured potential and current signals versus the time.
- **Lissajous**: plots the raw AC current versus the raw AC potential.

Five locations settings are available using the dedicated buttons, for each plot (see Figure 29).
For each plot, the location can be set to plot 1, 2, 3, or 4. If the plot should be created but not plotted, the plot location can be set to - (see Figure 30).

Figure 29 – The plot location can be specified for each plot individually

![Diagram showing plot locations]

Not plotted

Plotted on plot (1-4)

Figure 30 – The plot location of the plots (1-4), or not plotted (-)

4.1.5 – Summary

The Summary section of the FRA editor provides a complete summary of the frequency scan parameters defined in the FRA editor (see Figure 31).
Each frequency in the scan is displayed in the table, along with the amplitude values, wave type, minimum integration time and maximum number of cycles to integrate (see Figure 31).

A tooltip displays information about each individual frequency in the scan (see Figure 32).
The summary section can be used to fine tune the frequency scan in three different ways:

1. The parameters of one or more frequencies in the table can be adjusted manually (see Section 4.1.6).
2. Additional frequencies can be added manually to the table (see Section 4.1.7).
3. The frequencies can be sorted ascending or descending (see Section 4.1.8).

4.1.6 – Manual modification of parameters of the scan

If needed, one of more parameters can be overruled in the summary table shown in the Summary section. Double click the field to be edited in the table and modify the value (see Figure 33).

![Figure 33 – Modifying individual values in the Summary section](image)

Press the enter key to validate the new value. The new value will be used instead of the initial value specified in the Frequency scan section of the FRA editor (see Figure 34).
4.1.7 – Adding additional frequencies to the scan

If needed, additional frequencies can be added to the table presented in the Summary section, by clicking the *Add range* button (see Figure 35).

A new window will be displayed on top of the FRA editor, allowing the specification of an additional frequency range, with its own distribution and amplitude (see Figure 36).
4.1.8 – Sorting the frequencies in the frequency scan

It is possible to sort the frequencies ascending or descending in the Summary section by clicking the Frequency column header. A small arrow will be displayed in the column header indicating the sorting direction (see Figure 38).
4.1.9 – Resetting the changes

If a parameter is adjusted in the Frequency scan section or in the Sampler section after the frequency scan has been modified in the Summary section, a warning will be displayed indicating that the changes will be removed. Clicking the button will revert the change and keep the modified frequency scan (see Figure 39).
4.1.10 – Multi sine measurements

For very low frequency measurements, the multi sine option can be used to increase the acquisition speed. This option allows you to create a frequency scan in which low frequency single sine amplitudes are replaced by a linear combination of five or fifteen frequencies. Each multi sine signal generates a number of data points equal to the number of components in the linear combination.

The multi sine option is only available for low frequencies. The maximum frequencies for multi sine measurements are listed in Table 2.

<table>
<thead>
<tr>
<th>Module</th>
<th>5 sines frequency limit</th>
<th>15 sines frequency limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRA32M</td>
<td>320 Hz</td>
<td>32 Hz</td>
</tr>
<tr>
<td>FRA2</td>
<td>3472 Hz</td>
<td>315.7 Hz</td>
</tr>
</tbody>
</table>

Table 2 – The frequency limit for multi-sine measurement for the FRA32M and FRA2 modules

To create a multi sine frequency scan, the Wave type property can be manually set using the Wave type radio buttons provided on the Frequency scan section (see Figure 40).
The multi sine option allows you to create a linear combination of five or fifteen individual frequencies. Depending on the available hardware (FRA2 or FRA32M), the frequency scan will be generated and the multi sine signals will be used for the low frequencies in the range. The summary section displays the wave type in the table (see Figure 41).

The individual components of a multi sine signal are displayed in a tooltip (see Figure 42). The frequency displayed in the summary section is the lowest of the value of
the linear combination. The values displayed in the tooltip correspond to the higher harmonics in the linear combination.

Figure 42 – The higher harmonics of the multi sine frequencies are displayed in a tooltip

Clicking the **OK** button validates the frequency scan and closes the editor. The procedure editor will be updated (see Figure 43).
Depending on the signals selected in the Sampler section of the FRA editor, additional plots can be added to the command and can be displayed in real time. Clicking the button in the quick access toolbar displays the list of available plots (see Figure 44).
Figure 44 – The quick access menu can be used to quickly add extra plots to the command

Note
The list of plots shown in the drop down list in the quick access toolbar depends on the signals sampled through the FRA sampler, using the FRA editor.
5 – Impedance measurements on the dummy cell

A FRA impedance tutorial folder is located in the Program Files\Metrohm Autolab\Nova 1.1\Shared DataBase\Tutorials folder (see Figure 45). Using the database manager, set this folder as the Standard database.

![Database management interface](image)

**Figure 45 – Loading the FRA impedance tutorial database**

Six procedures are included in this tutorial procedure. All the procedures are intended to be used with the Autolab dummy cell (see Figure 46).

![Procedure list](image)

**Figure 46 – The six FRA impedance tutorial procedures**

This section describes the FRA tutorial procedures.

### 5.1 – FRA impedance tutorial #1 – Single sine frequency scan

Select the *FRA impedance tutorial #1* procedure from the Standards group. Connect dummy cell (c) and start the measurement.
After pressing the Start button, a message will be displayed (see Figure 47).

**Figure 47 – A message box is displayed at the beginning of the measurement**

Click the OK button to continue with the measurement. During the experiment, two plots are shown in the measurement view (see Figure 48). Plot #1 corresponds to the Nyquist plot (-Z'' vs Z') and plot #2 corresponds to the Bode plot (|Z| and -\(\phi\) vs frequency).

**Note**

Switch the measurement view to *Two plots vertically tiled* mode by pressing the button in the toolbar.

**Figure 48 – The measured values are displayed as a Nyquist plot (left, plot #1) and as a Bode plot (right, plot #2)**

Pressing the F10 key during the measurement shows the Autolab display window (see Figure 49).
Figure 49 – A detailed overview of the Autolab display during the impedance measurement (the Autolab manual control panel is collapsed)

The Autolab display shows the following additional information during the FRA measurement:

- **Frequency**\(^{14}\): this is the frequency which is currently applied by the FRA module.
- **E(\text{DC})** and **E(\text{DC})**: the measured DC and AC potential, in volts.
- **i(\text{AC})** and **i(\text{AC})**: the measured DC and AC current, in amperes.
- **% E** and **% i**: the experimental resolution of the two on-board A/D converters. For accurate results, the resolution should be as high as possible (at least 30\%)\(^{15}\).
- **Freq., Z, -Phase, Z’, -Z”**: the frequency of the last analyzed point and corresponding total impedance, phase angle, real and imaginary component.

\(^{14}\) In the case of a multi-sine measurement, the base frequency of the multi-sine signal will be displayed in the Autolab display.

\(^{15}\) During the measurement, the gain factors of both A/D converters are continuously adjusted in order to maximize the resolution.

---

**Note**

The pre-defined Nyquist plot uses isometric axes coupling so that the scale length of the real axis is the same as that the imaginary axis.
5.2 – FRA impedance tutorial #2 – Multi sine frequency scan

Select the FRA impedance tutorial #2 procedure from the Standards group. Connect dummy cell (c) and start the measurement.

After pressing the Start button, a message will be displayed (see Figure 50).

Click the OK button to continue with the measurement. During the measurement, the AC signal will switch from single sine at high frequencies to multi sine at low frequency. During the experiment, two plots are shown in the measurement view (see Figure 51). Plot #1 corresponds to the Nyquist plot ($-Z''$ vs $Z'$) and plot #2 corresponds to the Bode plot ($|Z|$ and $-\phi$ vs frequency).

Click the OK button to continue with the measurement. During the measurement, the AC signal will switch from single sine at high frequencies to multi sine at low frequency. During the experiment, two plots are shown in the measurement view (see Figure 51). Plot #1 corresponds to the Nyquist plot ($-Z''$ vs $Z'$) and plot #2 corresponds to the Bode plot ($|Z|$ and $-\phi$ vs frequency).

**Figure 50 – A message box is displayed at the beginning of the measurement**

**Figure 51 – The measured values are displayed as a Nyquist plot (left, plot #1) and as a Bode plot (right, plot #2)**

**Note**

The frequency distribution is not the same as in the first experiment (compare Figure 48 and Figure 51). This stems from the multisine component used in the second tutorial procedure. Multisine signals always contain a base frequency defined by the user and a number of higher harmonics (see Figure 42). The consequence is that there is an overlap in the frequency distribution, as seen in Figure 51.
Pressing the F10 key during the measurement shows the Autolab display window (see Figure 52). During multi-sine measurements, the values for all the calculated frequencies are shown in the FRA manual control panel.

![Autolab display](image)

*Figure 52 – A detailed overview of the Autolab display during a multi-sine impedance measurement (the Autolab manual control panel is collapsed)*

### 5.3 – FRA impedance tutorial #3 – Time domain data

Select the *FRA impedance tutorial #3* procedure from the Standards group. This procedure is identical to the procedure used in tutorial #1, except that the Sample time domain option is selected in Sampler section of the FRA editor (see Figure 53).
Sampling of the time domain information provides additional information which is not available in the standard Autolab procedures. The raw AC response is sampled and stored for the selected channels (potential and current in this procedure).

In this tutorial procedure, the additional data sampled during the measurement will be used to build a Lissajous plot (shown on plot #3) and a resolution plot (shown on plot #4). The location of these plots is assigned on the Plots section of the FRA editor (see Figure 54).
NOVA Impedance spectroscopy tutorial

Figure 54 – The plots used in the tutorial #3 procedure are specified in the Plots section of the FRA editor.

Note
Switch the measurement view to Four plots mode by pressing the button in the toolbar.

Connect dummy cell (c) and press the start button. A message box will be displayed as in the previous measurement (see Figure 55).

Figure 55 – A message box is displayed at the beginning of the measurement

During the measurement, a total of four plots are shown in the measurement view (see Figure 56).
Figure 56 – The measured values are displayed as a Nyquist plot (top left, plot #1) and a Bode plot (top right, plot #2). The additional time domain data is used to create a Lissajous plot (bottom left, plot #3) and a resolution plot (bottom right, plot #4).

**Note**

Since the data provided by the Collect time domain FRA data changes with each frequency, the Lissajous and the resolution plot are updated after each new frequency is measured.

### 5.4 – FRA impedance tutorial #4 – Real time data analysis

Select the *FRA impedance tutorial #4* procedure from the Standards group. This procedure is identical to the procedure used in tutorial #1, except that a *Fit and Simulation* command has been added to the procedure, at the end of the procedure (see Figure 57).
Connect dummy cell (c) and press the Start button. A reminder will be displayed (see Figure 58).

Click the OK button to continue with the measurement. During the experiment, the measured data points are displayed as Point plots (plot #1 corresponds to the Nyquist plot ($-Z''$ vs $Z'$) and plot #2 corresponds to the Bode plot ($|Z|$ and $-\phi$ vs frequency).

After the second data point is acquired, the fitting algorithm can start fitting the pre-defined model, $R(RC)$, to the measured data points (see Figure 59).
Figure 59 – The data measured during the Tutorial #4 procedure is fitted with a simple R(RC) equivalent circuit

The results of the calculations are overlaid as Line plots on plot #1 and plot #2 for the Nyquist and Bode plots, respectively (see Figure 60).

Note

Switch the measurement view to Two plots vertically tiled mode by pressing the button in the toolbar.

Figure 60 – The measured and fitted values are displayed as a Nyquist plot (left, plot #1) and as a Bode plot (right, plot #2)

Note

The fitting calculation is repeated automatically after each new data point. Repeating the calculation slows down the experiment with respect to the Tutorial #1 procedure.

5.5 – FRA impedance tutorial #5 – DC measurements in frequency scan

Select the FRA impedance tutorial #5 procedure from the Standards group. This procedure is identical to the procedure used in tutorial #1, except that the DC contributions measured and plotted during the experiment are plotted after each individual frequency (see Figure 61).

This procedure applies a DC potential of -0.5 V.
NOVA Impedance spectroscopy tutorial

During this procedure, the offset value measured on both input channels of the FRA module will be measured for one second, after each frequency. For frequencies higher than 25 Hz, the DC offset is filtered through a RC filter, for frequencies below 25 Hz, an independent offset compensation DAC is used on both channels.

Connect dummy cell (c) and press the Start button. A reminder will be displayed (see Figure 62).

Click OK to continue the measurement. In this tutorial procedure, the additional data provided by the Sample DC option of the FRA sampler is shown on plot #3 for Channel #1 and on plot #4 for Channel #2 (see Figure 63).

Switch the measurement view to Four plots mode by pressing the button in the toolbar.
Figure 63 – The measured values are displayed as a Nyquist plot (top left, plot #1) and a Bode plot (top right, plot #2). The additional data points provided by the Sample DC option of the FRA sampler are displayed on plot #3 and plot #4.

5.6 – FRA impedance tutorial #6 – Time scan

Select the FRA impedance tutorial #6 procedure from the Standards group. This procedure shows an example of a time scan. In this experiment, the impedance of the cell is measured at a fixed frequency of 10 kHz. The number of consecutive measurements is 20. After each individual frequency, a pause of ten seconds is introduced.

Figure 64 shows part of the procedure used in Tutorial #6. A Wait time command, with a duration of 10 seconds, has been added to the procedure, after the FRA single frequency command.
When the measurement is performed, the software will wait for 10 seconds after each new frequency measurement.

Connect dummy cell (c) and press the Start button. A reminder will be displayed (see Figure 65).

Click OK to continue the measurement. In this tutorial procedure, the recorded values of $Z$, $Z'$ and $-Z''$ are plotted versus time on plot #1 and plot #2, respectively (see Figure 66).

**Note**

Switch the measurement view to *Two plots vertically tiled* mode by pressing the button in the toolbar.
Figure 66 – The measured values of $Z$, $Z'$, $-Z''$ are displayed versus time

**Note**

The interval time between two consecutive points in the experiment depends on the data acquisition time for the FRA measurement. The exact interval time will be 10 seconds + the time required to measure the impedance data. Automatic current ranging and automatic gaining can increase the interval time.

6 – Impedance data analysis tools

Several data analysis and data handling tools are available in NOVA. These tools can be accessed by right-clicking an impedance measurement in the Analysis view (see Figure 67).

![Data analysis and data handling tools](image)

Figure 67 – Data analysis and data handling tools are available through the right-click menu in the Analysis view

It is also possible to add an analysis tool by using the quick access toolbar, through the button, as shown in Figure 68.
The following tools are available:

- **Electrochemical circle fit**: used to perform a quick fit of impedance data using a predefined R(RQ) equivalent circuit.
- **Fit and Simulation**: used to fit impedance data using a user-defined equivalent circuit model and to perform simulation of impedance data.
- **Kramers – Kronig**: used to test the validity of impedance data using the Kramers – Kronig relations.
- **Include all FRA data**: used to calculate additional data like the admittance data and the permittivity using the measured impedance data.
- **Potential scan FRA data**: used to calculate the data required to draw a Mott-Schottky plot. This tool can be used in combination with a Potential scan FRA measurement.

The use of these tools is explained in this section of the tutorial.

### 6.1 – Electrochemical circle fit

Analysis of the data obtained during an electrochemical impedance measurement is usually performed by fitting the experimental data with an equivalent circuit, based on the Boukamp model\(^\text{16}\).

In order to help in the estimation of the parameters of the equivalent circuit, an electrochemical circle fit tool is available from the Analysis tools. This simple tool calculates the values of the elements of the equivalent circuit shown in Figure 69, using the measured data points of a circular portion of the Nyquist plot (corresponding to a single time constant).

![Electrochemical circle fit tool](image)

**Figure 69 – The equivalent circuit used in the Electrochemical circle fit tool**

---

This circuit includes the following items:

- **Rs (Ohm)** – used to simulate the value of the uncompensated resistance
- **Rp (Ohm)** – used to simulate the polarization resistance (also referred to as the charge transfer resistance)
- **CPE** – the value of the argument of the constant phase element (also referred to as a Q element)
- **n** – the value of the exponent of the constant phase element

In order to use the Electrochemical circle fit tool in NOVA, load the data from the Tutorial #1 procedure\(^\text{17}\) and add the Electrochemical circle fit analysis tool to the data by right-clicking the FRA measurement line in the data explorer frame and selecting the **Electrochemical circle fit** tool from the analysis menu (see Figure 70).

\(^{17}\) Or any other set of FRA data.
Figure 71 – Adding the Electrochemical circle fit analysis tool to the data set

The Electrochemical circle fit automatically displays the data in the Nyquist format and changes the mouse pointer to a cross. The control parameters of the fit tool are displayed on the right-hand side of the plot (see Figure 72).

The Electrochemical circle fit tool requires the selection of at least three measured data points in the complex plane in order to fit a semi-circle through the selected points and calculate the equivalent circuit element values. Using the mouse, click three or more data points in the Nyquist plot to define the semi-circle to use in the calculation.

By default, the tool will find the closest data point with respect to the clicked point on the Nyquist plot (Snap to data). If an arbitrary position is required, the Data selection method can be set to Free selection using the radio buttons in the control parameters of the Electrochemical circle fit tool (see Figure 73).
Data selection method

- Snap to data
- Free selection

Number of significant digits

5

Reset

Figure 73 – The control parameters of the Electrochemical circle fit tool

After the third point is clicked, the fitted circle will be plotted in the plot area and the calculated values of Rs, Rp, CPE and n, for the fitted circle will be displayed in the data explorer frame, below the Electrochemical circle fit item (see Figure 74).

Figure 74 – Three data points are required for the Electrochemical circle fit tool

The position of the center (X, Y coordinates) of the semi-circle as well as the angle between the X axis and the [(0, 0), (X, Y)] segment are also calculated.

It is possible to modify the selected data points even after the electrochemical circle fit has finished. To do this, right click on any of the three selected arrow markers and select the Move option from the right-click menu (see Figure 75).
Choosing the Move option from the right-click menu allows moving the selection on the semi-circle.

The selected marker will become free to move and a label will be displayed below the point. Pressing the left or right arrow key on the keyboard will move the selected point left or right (see Figure 75).

Press the Enter key to validate the new position of the marker. The circle fit will be recalculated and the new results will be displayed in the data explorer.

**Note**

It is possible to add as many Electrochemical circle fit analysis tools to a measurement as required.

The Electrochemical circle fit tool can be used to quickly fit an apparent semi-circle in a Nyquist plot. However, if an accurate derivation of the equivalent circuit is needed, the Fit and Simulation analysis tool must be used. Section 6.2 provides more information about this tool. To simplify the fitting or the simulation of data using the Fit and Simulation tool, it is possible to copy the results of the Electrochemical circle fit analysis tool (see Figure 76).
The saved data can be used in the Fit and Simulation tool (see Section 6.2.8).

### 6.2 – Fit and Simulation

Detailed analysis of the data obtained during an electrochemical impedance measurement is usually performed by fitting the experimental data with an equivalent circuit, based on the Boukamp model. Many circuit elements can be used to fit the experimental data with a model. However, the equivalent circuit must be constructed carefully, since a given experimental data set can be fitted with more than one unique equivalent circuit.
The fit and simulation tool allows the definition of an equivalent circuit using the following elements (see Table 3):

<table>
<thead>
<tr>
<th>Element</th>
<th>Symbol</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>R, resistance</td>
<td><img src="resistor.png" alt="Resistor" /></td>
<td>$Z_R = R$</td>
</tr>
<tr>
<td>C, capacitance</td>
<td><img src="capacitor.png" alt="Capacitor" /></td>
<td>$Z_C = -\frac{j}{\omega \cdot C}$</td>
</tr>
<tr>
<td>L, inductance</td>
<td><img src="inductor.png" alt="Inductor" /></td>
<td>$Z_L = j\omega L$</td>
</tr>
<tr>
<td>Q, constant phase element</td>
<td><img src="phase_element.png" alt="Phase Element" /></td>
<td>$Z_Q = \frac{1}{Y_0(j\omega)^n}$</td>
</tr>
<tr>
<td>W, Warburg impedance</td>
<td><img src="warburg_impedance.png" alt="Warburg Impedance" /></td>
<td>$Z_W = \frac{1}{Y_0 \sqrt{j\omega}}$</td>
</tr>
<tr>
<td>O, cotangent hyperbolic</td>
<td><img src="cotangent_hyperbolic.png" alt="Cotangent Hyperbolic" /></td>
<td>$Z_O = \frac{1}{Y_0 \sqrt{j\omega} \tanh(B\sqrt{j\omega})}$</td>
</tr>
<tr>
<td>T, tangent hyperbolic</td>
<td><img src="tangent_hyperbolic.png" alt="Tangent Hyperbolic" /></td>
<td>$Z_T = \frac{1}{Y_0 \sqrt{j\omega} \coth(B\sqrt{j\omega})}$</td>
</tr>
<tr>
<td>G, Gerischer impedance</td>
<td><img src="gerischer_impedance.png" alt="Gerischer Impedance" /></td>
<td>$Z_G = \frac{1}{Y_0 \sqrt{k_a + j\omega}}$</td>
</tr>
<tr>
<td>B2, Bisquert #2</td>
<td><img src="bisquert_2.png" alt="Bisquert #2" /></td>
<td>See Appendix for details</td>
</tr>
</tbody>
</table>

Table 3 – Overview of the available equivalent circuit elements

The circuit elements can be arranged in series or in parallel. The impedance of series element is given by the sum of the impedance values of each individual element, while the impedance of the element placed in parallel is given by the reciprocal of the sum of the reciprocal impedance values of each element.

In order to use the fit and simulation tool in NOVA, load the data from the Tutorial #1 procedure\(^{18}\) and add the fit and simulation analysis tool to the data by right-clicking the FRA measurement line in the data explorer frame and selecting the Fit and Simulation tool from the analysis menu (see Figure 77).

---

\(^{18}\) Or any other set of FRA data.
Figure 77 – Selecting the Fit and Simulation tool from the Add Analysis menu (top) and the quick access toolbar (bottom)

A new item, called Fit and Simulation, will be added to the data set in the explorer frame (see Figure 78).

Figure 78 – Adding the Fit and Simulation analysis tool to the data set

The Fit and Simulation tool automatically generates a Nyquist and a Bode plot, as well as the error plot for both $Z'$ and $-Z''$. However, since no equivalent circuit has been defined yet, none of these plots can be displayed. Moreover, the Fit and
NOVA Impedance spectroscopy tutorial

Simulation tool indicates that no convergence has been reached, the number of iterations is 0 and the value of \( \chi^2 \) has not been calculated yet (see Figure 78).

Click the Fit and Simulation analysis tool to display the control parameters in the frame on the right-hand side of the plot (see Figure 79).

<table>
<thead>
<tr>
<th>Signal</th>
<th>Expression</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( Z' )</td>
<td>Ω</td>
<td></td>
</tr>
<tr>
<td>( -Z'' )</td>
<td>Ω</td>
<td></td>
</tr>
<tr>
<td>Error ( Z' )</td>
<td>%</td>
<td></td>
</tr>
<tr>
<td>Error ( Z'' )</td>
<td>%</td>
<td></td>
</tr>
<tr>
<td>( \theta )</td>
<td>°</td>
<td></td>
</tr>
<tr>
<td>Frequency</td>
<td>Hz</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 79 – Clicking the Fit and Simulation tool reveals the control parameters on the right**

The Fit and Simulation control interface has a number of values and settings:

- **Maximum number of iterations**: defines the number of consecutive calculations used during the fitting calculation. The default value is 300.
- **Maximum change in Chi square (scaled)**: defines one of the convergence criteria. The fitting will finish when the absolute change in the Chi square parameter (including weight factors) will be lower than this value. The default value is 0.001.
- **Max. iterations without improvement**: defines a second stop condition for the fitting calculation. This number defines the number of iterations that are allowed during which the Chi square value does not improve. When this value is reached the fitting calculation is stopped. The default value is 50.
- **Fitting style**: (impedance/admittance) – defines whether the calculation should use the impedance or the admittance values during the fit.
- **Use weight factors**: (yes / no) – defines whether a weight factor should be used during the calculation. If weight factors are used, each point is multiplied by a weight factor equal to the inverse of the square of the
impedance modulus. If this option is not used, the weight factor is the same for each point, i.e. the inverse of the square root of the average of the impedance modulus.

- **Fit or Simulation**: defines the calculation method. Using the Fit methods, the software will try to find the most suitable values for the parameters of each element defined in the equivalent circuit, starting with initial, user-defined values. The simulation method simply calculates the impedance values for the equivalent circuit, as it is defined by the user.

- **Measurement data format**: (impedance/admittance) – defines the type of data of the data set.

- **Number of significant digits**: defines the number of significant digits used to display the results of the calculation.

The Fit and Simulation tool requires the definition of an equivalent circuit as well as initial conditions. This can be done by clicking the **Edit** button located next to the Circuit field in the Fit and Simulation control interface (see Error! Reference source not found.).

The Equivalent Circuit Editor window will be displayed (see Figure 80). This window can be used to define the equivalent circuit used to fit or to simulate the data, as well as the initial conditions for the calculation.

![Figure 80 – The Equivalent Circuit Editor window](image-url)
NOVA Impedance spectroscopy tutorial

The Equivalent Circuit Editor window provides a graphical environment in which an equivalent circuit can be drawn and edited. Three strategies can be used to create an equivalent circuit:

1. By typing a properly formatted CDC\textsuperscript{19} string
2. By inserting a pre-defined equivalent circuit included with the software
3. By drawing the equivalent circuit using the individual circuit element

6.2.1 – Generating an equivalent circuit from a CDC string

To define the equivalent circuit from a CDC string, select the \textit{Generate Circuit from CDC} option from Tools menu (see Figure 81).

A new window that can be used to input the CDC string will be displayed (see Figure 82). To define the CDC string, the following syntax rules must be followed:

- Any of the eight element symbols defined in Table 3 can be used
- Element placed in parallel must be written between ()
- Element placed in series must be written between []

\textsuperscript{19} Circuit Description Code, see Solid State Ionics, 20 (1986) 31-44.
For example, the equivalent circuit displayed in Figure 83, can be defined by:

- $R(Q)$, where the first $R$ corresponds to $R_s$, the second $R$ corresponds to $R_p$, which is in parallel with a constant phase element, represented by the $Q$ element.

![Figure 83 – A simple equivalent circuit (Randles cell)](image)

Once the CDC string is defined, click the OK button to create the circuit. The equivalent circuit will be drawn in the Equivalent Circuit Editor window, displaying the default initial values of the circuit elements (see Figure 84).

![Figure 84 – The equivalent circuit is generated from the CDC string](image)

**Note**

If the CDC string is invalid, an error message will be displayed (see Figure 85).
An error message is displayed if the CDC string is invalid

6.2.2 – Loading a pre-defined equivalent circuit from a list

It is possible to choose an equivalent circuit from a pre-defined list of typical or user-defined circuits. To do this, select the *Open Circuit* option from the Circuit menu (see Figure 86).

A new window will be displayed, showing two tabs (see Figure 87):

- **Pre-defined circuits**: this list contains a number of typical equivalent circuits
- **User-defined circuits**: this list contains user-defined circuits (see Section 6.2.9 for more information)
The library provides two lists of pre-defined equivalent circuits. Select the required equivalent circuit from either list and click the OK button. The selected equivalent circuit will be drawn in the Equivalent Circuit Editor window. The default or user-defined initial values will be displayed in blue (see Figure 88).

**Note**

If the *Insert Circuit* option is selected instead of the *Open circuit* option, the selected circuit will be added to the Equivalent Circuit Editor without clearing the editor first.
The equivalent circuit is loaded from the circuit library

6.2.3 – Drawing the equivalent circuit using individual circuit elements

The Equivalent Circuit Editor window can also be used to draw the equivalent circuit by connecting individual element to one another, graphically. Right-clicking the editor window displays a context menu from which an element or a connection can be selected (see Figure 89).
Individual circuit elements can be added by right-clicking the Equivalent Circuit Editor window.

Note

It is also possible to add a circuit element to the editor from the Insert option available in the Edit menu (see Figure 90).

Figure 90 – It is also possible to add circuit elements directly from the Edit – Insert menu.
NOVA Impedance spectroscopy tutorial

Using the right-click menu, select the Resistance element from the Add element submenu, as shown in Figure 89. The resistance will be drawn in the Editor and the default values for this element will be displayed in blue (see Figure 91).

![Figure 91](image)

**Figure 91 – The selected element is drawn in the Editor**

Using the right-click menu (or the Insert option) other circuit element can be added to the Editor. To connect two or more circuit element to one another, a connection must be added to the Editor. This can be done by selecting the Add connection option from the right-click menu (see Figure 92).
Three different connections are available from the Add connection menu (see Figure 92):

- **Serial**: this is a simple direct connection between two elements placed in series.
- **Parallel split**: this is a connection that introduces a splitting, allowing a circuit element to be connected to two additional elements placed in parallel.
- **Parallel join**: this is a connection that joins two parallel circuit branches.

Figure 93 shows the three available connection types.

Once a connection has been added to the Editor, it can be used to connect elements. Click the •-end of the connection and while holding the mouse button, drag it over the –C end of the resistance. When the two ends are close enough in the editor, the software will automatically link the connection to the element (see Figure 94).
NOVA Impedance spectroscopy tutorial

Figure 94 – The software automatically connects the \( \circ \) end of the connection to the \( \circ \) end of the resistance once the two ends are close enough.

The same can be repeated with the \( \circ \) end of the connection, which can be connected to the \( \circ \) end of the capacitance (see Figure 95).

The circuit shown in Figure 95 corresponds to an RC series. To add an element in parallel, the serial connection can be replaced by a parallel split connection. Click the serial connection to select it and press the delete key to remove it.

Add a parallel split from the add connection menu and connect the resistance and the capacitance to one another, leaving one of the parallel ends free (see Figure 96).

Alternatively, an additional output connection in the circuit can be added to the existing connection. This can be done by right-clicking an existing connection and selecting the Add output option from the context menu. This will transform a serial connection into a parallel split connection (see Figure 97).
NOVA Impedance spectroscopy tutorial

Figure 97 – An output can be added to an existing connection in the circuit using the right-click menu

Once the parallel split connection is created, a new element can be added to the circuit (see Figure 98).

Figure 98 – Additional elements can be added to the circuit

To close the parallel connection shown in Figure 98, simply add a parallel join connection to the circuit, using the right-click menu (see Figure 99).

Figure 99 – An parallel join connection can be added to the equivalent circuit using the right-click menu

The two free •-ends can now be used to close the parallel connection (see Figure 100).
NOVA Impedance spectroscopy tutorial

Figure 100 – Closing the parallel connection in the equivalent circuit

![Figure 100](image)

**Note**

It is possible to check the equivalent circuit for errors by selecting the *Generate CDC from Circuit* option from the Tools menu. If the circuit is valid, the CDC string will be shown displayed (see Figure 101).

![Figure 101](image)

Figure 101 - The Generate CDC from circuit can be used to verify the equivalent circuit

An error message is displayed when the equivalent circuit is invalid (see Figure 102).
Figure 102 – An error message is displayed when the equivalent circuit is invalid

**Reminder**

The equivalent circuit is valid if all the connections are properly linked (indicated by the linked symbol, $\equiv$). The circuit can only have one single unlinked $\bullet$ end and one single unlinked $\rightarrow C$ end.

6.2.4 – Parameter editing

Once the equivalent circuit is defined in the editor, it is possible to edit the parameters of each individual element. Select one of the circuit elements by clicking it in the editor. The selected element will be highlighted as shown in Figure 103.

With the element selected, move the mouse pointer over the Properties tab on the right-hand side. The properties tab will be expanded, revealing the parameters of the selected element (see Figure 104).
The properties page shows a container for each element parameter, which can be expanded or collapsed to reveal or to hide advanced variables (see Figure 105).

The following **basic** variables can be edited for each individual element:

- **Name**: defines an optional name to identify the element.
• **Start**: defines the initial value of the variable of the circuit element.
• **Fitted**: the calculated value of the variable (see section 6.2.5).
• **Fixed**: (yes/no) – defines whether the value of the variable can be changed during the fitting of the data. The default setting is no (unchecked).

The following **advanced** variables can be edited for each individual element:

• **Min**: defines the lowest possible value for the variable of the element, to be used during the fitting of the data.
• **Max**: defines the highest possible value for the variable of the element, to be used during the fitting of the data.
• **Apply limits**: (yes/no) – defines whether the Lower and Upper limit should be used during the fitting of the data. The default setting is yes.
• **Input**: (yes/no) – defines if a linkable input parameter has to be shown in the procedure editor for the selected element parameter. This linkable parameter can be used to specify the **Start** value. The default setting is no. The linkable parameter will only be displayed in the procedure editor if a name is specified in the **Name** field. The linkable parameter will be displayed as **Input <name>.<Element parameter symbol>** (see Figure 106).
• **Output**: (yes/no) – defines if a linkable output parameter has to be shown in the procedure editor for the selected element parameter. This linkable parameter can be used to link the **Fitted** value to another parameter in the procedure. The default setting is no. The linkable parameter will only be displayed in the procedure editor if a name is specified in the **Name** field. The linkable parameter will be displayed as **<name>.<Element parameter symbol>** (see Figure 106).
Figure 106 – Using the Input and Output variable in the procedure editor for the R parameter of a circuit element called Resistance (Output: Resistance.R, Input: Input Resistance.R)

Note

Some circuit elements have more than one parameter. The variables can be defined for each parameter, independently.

To keep the properties tab expanded, click the pushpin icon, ▪. When the pushpin icon is pressed, the properties tab will remain expanded even if no element is selected in the editor.

It is possible to fix the value of the one or more of the variables of the elements in the equivalent circuit by checking the Fixed checkbox in the properties tab. Fixed variables will be shown in red in the editor (see Figure 107).
Once the fitting conditions have been defined, the calculation can be performed.

6.2.5 – Running the calculation

Once the initial conditions have been defined for the equivalent circuit, the calculation can be started. Select the Run Fit and Simulation from the Tools menu or press the F5 shortcut key to start the calculation (see Figure 108).

The calculation will start and a progress dialog will be displayed (see Figure 109).
Figure 109 – A progress dialog is displayed during the fitting of the data

The fitting of the data will stop when:

1. Convergence is reached.
2. One of the stop conditions is met (see Figure 79).
3. The Cancel button was pressed in the fitting dialog.

When the calculation is finished, the calculated values will be displayed in the editor (see Figure 110).

Figure 110 – When the calculation is finished, the values shown in the editor will be updated

Note

Fixed parameters are not updated at the end of the calculation, as shown in Figure 110 for the \( n \) parameter of the constant phase element, Q.
After the calculation, the properties tab will be updated and the fitted value of each parameter, as well as the estimated error, will be shown in the Fitted field (see Figure 110).

The estimated error, expressed in % of the calculated value, represents the margin of confidence of the calculated value determined by the fitting algorithm. The goodness to fit of the data, represented by the calculated $\chi^2$ value, is more sensitive towards modifications of parameter values with a high estimated error.

Large estimated errors are typically an indication of an incorrect model. This is often the case of equivalent circuits containing more elements than are represented by the data.

It is possible to adjust some of the parameters after the calculation is finished. To change the start value of one or more of the parameters, simply edit the Start value field (see Figure 111). This will remove the calculated value from the matching Fitted value field.

![Equivalent Circuit Editor](image)

**Figure 111 – It is possible to adjust the parameters after the calculation is finished**

Start the calculation again (F5 key or Run Fit and Simulation from the Tools menu). The fitting will be restarted using the new start values defined in the element properties tab. Figure 112 shows the results obtained after restarting the calculation with an adjusted initial value for the admittance, Y0, of the Q element.
Unchecking the Fixed status of one or more parameters yields the same result: the Fitted value field is cleared and the Start value field is adjusted (see Figure 113).

**Note**

Fixed parameters are always displayed in red. Variable parameters are displayed in blue.
Figure 113 – The calculation can be restarted at any time using new settings for the circuit parameters

On the other hand, it is possible to use one or more of the calculated values as new starting conditions for the calculation, by clicking the located on the properties tab, next to the Fitted value field. In that case, the calculated value of a parameter will be copied to the Fitted value field to the Start value field (see Figure 114).

**Note**

The Fitted value field is cleared when the button is pressed.
Finally, it is possible to resume the calculation, using all the Fitted values as new Start values for each individual equivalent circuit element. Select the Resume Fit and Simulation from the Tools menu or press the F9 shortcut key to resume the calculation (see Figure 115).
Figure 116 – When the calculation is resumed, the Fitted values are used as new Start values for all the parameters

Note

The data explorer frame is also updated after each calculation (see Figure 117).
In the example shown in Figure 117, the convergence has been achieved after 23 iterations, resulting in a $\chi^2$ value of 8.4071E-5.

6.2.6 – Dynamic command parameters

The Fit and Simulation command supports the use of dynamic command parameters. The possibility to assign a unique name to each individual circuit element is provided to the user on the properties tab (see Figure 118).
Assigning a name to a circuit element provides a convenient way to identify the element in an equivalent circuit.

If the calculation is performed again, the calculated value(s) of circuit elements identified with a specific name by the user will become available for additional data handling and calculations. The calculated values are also shown in the data explorer frame, if the **Output** checkbox, √, is selected for the circuit element (see Figure 118 and Figure 119).

![Figure 119](image)

**Figure 119** – The calculated values of elements identified with a unique name will be shown in the data explorer frame

### 6.2.7 – Displaying the results

After the calculation is finished, it is possible to view any of the available plots displayed below the Fit and Simulation analysis item. It is also possible to change the plot settings of the fitted plots and create an overlay of the calculated values and the measured values (see Figure 120).
Figure 120 – Creating an overlay – the measured data points are shown in blue, the calculated values are shown in red

To view the detailed values of all the parameters after the calculation, select the Generate Report option from the Tools menu (see Figure 121).

A report window will be displayed, showing the values, estimated errors for each individual element and the value of $\chi^2$ (see Figure 122).
It is possible to export the results from the Circuit report window to ASCII using the File menu (see Figure 123).

![Figure 123](image)

Figure 123 – It is possible to export the results to Excel or to ASCII

It is also possible to copy one or more of the values in the table to the clipboard (see Figure 124).

![Figure 124](image)

Figure 124 – Copy the results to the clipboard

**Note**

Elements identified with a unique name will be shown in the report with the user-defined name.
6.2.8 – Advanced editing

Additional tools are provided in the equivalent circuit editor. These can be used at any time to further edit the equivalent circuit:

- **Copy/Cut and Paste element(s):** select one or more elements in the equivalent editor by dragging a box around the circuit element and selecting the *Copy* or *Cut* option from the Edit menu (or the right-click menu or the CTRL-C/CTRL-X keyboard shortcuts) to copy them to the clipboard (see Figure 125). The copied elements can then be pasted into the equivalent circuit editor, using the *Paste* option from the Edit menu (or the right-click menu or the CTRL-V keyboard shortcut).

![Equivalent Circuit Editor](image)

*Figure 125 – Selected circuit elements can be copied/pasted directly in the editor*

**Note**

The parameter values of the selected items are also copied to the clipboard (see Figure 126).
Elements pasted into the equivalent circuit editor have the same parameter values as the source elements.

- **Change element type:** right-clicking a circuit element displays a context menu which can be used to change the equivalent circuit element from one type to another (see Figure 127).

When the element type is changed, the defaults values of the new element type will replace the parameter values of the original element.

- **Copy from Electrochemical circle fit:** the results of the Electrochemical circle fit tool can be pasted directly into the Equivalent circuit window. In order to do this, right-click on the Electrochemical circle fit tool and select the *Copy as Equivalent Circuit* from the context menu, as shown in Figure 76. Copy these results in the Equivalent Circuit Editor window (see Figure 128).
The results from the Electrochemical circle fit can be copied and pasted directly in the Equivalent circuit editor.

### 6.2.9 – Saving circuits

Any equivalent circuit can be saved into a user-defined database for future use. The equivalent circuits saved in this database will become available to the user from the Open/Insert circuit library as described in Section 6.2.2. To save the circuit into the database, select the **Save Circuit** option from the Circuit menu (see Figure 129).

A new window will be displayed, prompting for the name of the equivalent circuit (see Figure 130). Specify a name for the circuit and press the OK button to save it in the database.
Once the circuit has been saved, it will be available in the circuit library. It can be opened or inserted into the equivalent circuit editor window (see Figure 131).

The location of the database used to store the user-defined equivalent circuits can be defined using the Database manager, available from the Tools menu in Nova (see Figure 132).
The location of the user-defined circuit database can be defined in the Database manager. It is possible to right-click a saved equivalent circuit to rename the circuit or delete it. It is also possible to quickly locate the file on the computer by selecting the Show in Windows Explorer option (see Figure 133).

Right-clicking the saved circuit allows renaming, deleting or quick access to the file location.
6.2.10 – Exporting and importing circuits

It is possible to export equivalent circuits or to import equivalent circuits using the File menu (see Figure 134).

![Figure 134](image)

Figure 134 – It is possible to import and export circuits from the File menu

The following options are provided in the File menu:

- **Import Circuit**: this option can be used to import an equivalent circuit stored as an .ece file, created using NOVA.
- **Export Circuit**: the option can be used to export the active equivalent circuit to an .ece file.
- **Import FRA Circuit**: this option can be used to import an equivalent circuit stored as an .ecc file, created the Autolab FRA software.

**Note**

The E equivalent circuit element used in the FRA equivalent circuits is converted to a Q element in NOVA.

6.2.11 – Simulating experimental data

The simulation tool can be used to calculate the expected behavior of a user-defined equivalent circuit. To use the simulation tool, the equivalent circuit must first be defined, in the same way as for the fitting procedure. However, the Fit or Simulation parameter in the control interface must be set to Simulation (see Figure 135).
Figure 135 – To use the simulation tool, the Fit or Simulation parameter must be set accordingly.

The simulation is performed automatically and the results are immediately available for plotting. Figure 136 shows an example of simulated data, compared to the initial measured data points used in this example.

**6.2.12 – Pseudo capacitance determination**

It is possible to use the fitting and simulation tool to simplify a parallel combination of a resistor and a constant phase element (RQ) by converting the Q element to pseudo capacitance according to:

\[ C_{pseudo} = Y_0 \frac{1}{n} \cdot R^{\frac{1}{n} - 1} \]

Where \( C_{pseudo} \) is the resulting pseudo capacitance, in F, \( Y_0 \) is the admittance value of the constant phase element, \( R \) is the resistance value and \( n \) is the exponent of the constant phase element.
To use this conversion tool, right click a constant phase element in parallel with a resistance and select the *Convert to pseudo capacitance* option from the context menu, as shown in Figure 137.

![Figure 137 – Converting a Q element to a pseudo capacitance](image)

For example, a Q element with a $Y_0$ value of 1 µMho and a $n$ factor of 0.75, in parallel with a resistance of 1000 Ohm will be converted to a pseudo capacitance of 51.8 nF.

**Note**

The characteristic time constant of the RCpseudo will be the same as the original RQ circuit.

### 6.3 – Kronig-Kramers test

The Kronig-Kramers relations are mathematical properties which connect the real and imaginary parts of any complex function. These relations are often used to relate the real and imaginary parts of a complex transfer function (like electrochemical impedance, $Z$). This test can be used to check whether the measured data comply with the assumptions of Kronig-Kramers transformation. These assumptions are:

1. **Causality**: the response is only related to the excitation signal.
2. **Linearity**: the response is linear and the perturbation is small.
3. **Stability**: the system does not change with time.

Additionally, it is also assumed that:

4. The system is finite for all values of $\omega$, including zero and infinity.

If the investigated system changes with time due to e.g. ageing, temperature change, non-equilibrium initial state etc., the test fails. Failure of K-K test usually means that no good fit can be obtained using the equivalent circuit method. This analysis tool is based on the work of Dr. B.A. Boukamp as published in *J. Electrochem. Soc.*, Vol 142, 6 (June 1995) and coded in the program RCNTRANS by the same author.
The Kronig-Kramers (KK) test can be used to check whether the measured system is stable in time and linear. Stability and linearity are a prerequisite for fitting equivalent circuits. If the system changes in time, the data points measured on the beginning of the experiment do not agree with those measured at the end of the experiment. Since stability problems are most likely to be observed in low frequency range, the implementation of electrochemical impedance spectroscopy usually involves scanning from high to low frequency.

During the KK test, the experimental data points are fitted using a special model circuit which always satisfies the KK relations. If the measured data set can be represented with this circuit, then the data set should also satisfy Kronig-Kramers assumptions. The special circuit used in the test is a series of RC circuits (for impedance representation) or a ladder of serial RC arrangements (for admittance representation). These circuits are shown below (Figure 138).

![Circuit used in for KK test on impedance presentation](image)

By default, the number of RC circuits or RC serial arrangements is equal to the number of data points. If there is a chance that the measured signal was very noisy, the number of circuits may be reduced to avoid over fitting and, consequently, including the noise in the model.

The result of the test is the value of pseudo, $\chi^2_{ps}$, the sum of squares of the relative residuals. In each case the $\chi^2$ for the real and the imaginary part is reported (overall $\chi^2$ is a sum of real and imaginary $\chi^2$). Large $\chi^2$ values indicate that the data quality is low. A small value, on the other hand, usually indicates a good fit.

$$
\chi^2_{ps} = \sum_{i=1}^{N} \left\{ \frac{[Z_{re,i} - Z_{re}(\omega_i)]^2 + [Z_{im,i} - Z_{im}(\omega_i)]^2}{|Z(\omega_i)|} \right\}
$$

$$
\chi^2_{re} = \sum_{i=1}^{N} \frac{[Z_{re,i} - Z_{re}(\omega_i)]^2}{|Z(\omega_i)|} \quad \chi^2_{im} = \sum_{i=1}^{N} \frac{[Z_{im,i} - Z_{im}(\omega_i)]^2}{|Z(\omega_i)|}
$$

What is actually large and small depends on the number and the value of data points. As a rule of thumb, values lower than $10^{-6}$ usually means an excellent fit, reasonable between $10^{-5}$ and $10^{-6}$, marginal between $10^{-4}$ and $10^{-5}$ and bad for even higher values. Moreover, the residuals should be small and randomly distributed around zero.

The test can be carried out on real part, imaginary part or both part of admittance/impedance (complex fit). In the case of fit on one part only, the second part of the measured data set is generated using KK transformation (using the
assumption that the system obeys KK criteria) and then \( \chi^2 \) for the second part is computed.

In addition to \( \chi^2 \), the serial or parallel (depending on representation) \( R, L \) and \( C \) values are computed (see circuits). These values do not have any special meaning and they simply belong to the set of results of KK test. In particular, they should not be associated with any serial or parallel elements present in the system or its equivalent circuit representation.

The detailed discussion of the Kramers-Kronig test, the theory underlying the choice of parameters, and a refined interpretation of the outcomes can be found in the article of Dr. B.A. Boukamp. It is advised to read this article before this option is used.

In order to use the KK tool in NOVA, load the data from the Tutorial #1 procedure and add the Kronig-Kramers analysis tool to the data by right-clicking the FRA measurement line in the data explorer frame and selecting the Kronig-Kramers tool from the analysis menu (see Figure 139).

A new item, called Kronig-Kramers, will be added to the data set in the data explorer frame (see Figure 140). As soon as the analysis item is added to the data set, the

---

21 Or any other set of FRA data.
calculation is performed automatically, using the default settings. The calculated data points are available, after the calculation, in a Nyquist plot and a Bode plot, as well as in a residual plot for both $Z'$ and $-Z''$ (see Figure 140).

![Nyquist-Z'' vs Z'](image)

$\chi^2(Z) = 6.4106E-7$
$\chi^2(Z') = 3.2067E-7$
$\chi^2(-Z'') = 3.2033E-7$

Figure 140 – Adding the Kronig-Kramers analysis tool to the data set

Click the Kronig-Kramers analysis tool to display the control parameters in the frame on the right-hand side of the plot area (see Figure 141).

![Kronig-Kramers control interface](image)

Figure 141 – Clicking the Kronig-Kramers tool reveals the control parameters on the right-hand side

The KK control interface has a number of values and settings (see Figure 142).
The control parameters of the KK analysis tool:

- **Use number of frequencies (yes / no):** sets the number of (RC) circuit elements equal to the number of frequencies in the data set.
- **Number of subcircuits:** defines the number of (RC) circuit elements to use in the KK test. This number must be smaller or equal to the number of data points. It is possible to define this number if the *Use number of frequencies* parameter is set to no.
- **Test type (Complex / Real / Imaginary):** defines which part of the data set should be fitted using the distributed equivalent circuit.
- **Frequency per decade, extension:** this defines the so-called Tau-factor.
- **Test data (Impedance):** defines the type of data to fit. The current version of the KK test supports Impedance test only.

The calculation is performed as soon as a control parameter is modified. At the end of the calculation, the $\chi^2$ values can be used to evaluate the data. The residual plots can also be used to estimate the goodness-to-fit of the data set (see Figure 143).
The Include all FRA data tool can be used to automatically calculate and display additional information that can be derived mathematically from impedance data. To use this data handling tool, load the data from the Tutorial #1 procedure and select the Include all FRA data from the context menu (see Figure 144).

22 Or any other set of FRA data.
Figure 144 – Selecting the Include all FRA data tool from the Add Analysis menu (top) or the quick access toolbar (bottom)

A new item, called **Include all FRA data**, will be added to the data set in the explorer frame (see Figure 145). Two plots, Nyquist $-\gamma''$ vs $\gamma'$ and Epsilon plot, will be automatically and generated added to this item.

Figure 145 – The Include all FRA data tool automatically generates the Admittance plot and the Epsilon plot
NOVA Impedance spectroscopy tutorial

Table 4 provides an overview of the additional values calculated by the *Include all FRA data* tool:

<table>
<thead>
<tr>
<th>Value</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real admittance, $Y'$</td>
<td>$\frac{Z'}{</td>
</tr>
<tr>
<td>Imaginary admittance, $-Y''$</td>
<td>$\frac{-Z''}{</td>
</tr>
<tr>
<td>Angular frequency, $\omega$</td>
<td>$2\pi \cdot f$</td>
</tr>
<tr>
<td>Geometric capacitance, $\varepsilon$</td>
<td>1</td>
</tr>
<tr>
<td>Real permittivity, $Y\varepsilon'$</td>
<td>$\Re \left( \frac{Y' - jY''}{j\omega\varepsilon} \right)$</td>
</tr>
<tr>
<td>Imaginary permittivity, $-Y\varepsilon''$</td>
<td>$\Im \left( \frac{Y' - jY''}{j\omega\varepsilon} \right)$</td>
</tr>
<tr>
<td>Series capacitance, $C_s$</td>
<td>$-\frac{1}{\omega Z''}$</td>
</tr>
</tbody>
</table>

Table 4 – Overview of the values calculated by the *Include all FRA data* analysis tool

**Note**

The permittivity values are calculated using the value of the Geometric capacitance $\varepsilon$. This value is set to 1 by default, but it can be changed by selecting the $\varepsilon$ signal in the list of signals shown in the frame on the right-hand side of the Analysis view and clicking the Edit signal button in the toolbar (see Figure 146).

![Figure 146 – Changing the value of $\varepsilon$](image)
The calculate signal window will appear. The value of $\varepsilon$ can be adjusted in the Expression field (see Figure 147).

Press the OK button to validate the change of the $\varepsilon$ value. The values generated by the include all FRA data analysis tool will be automatically recalculated using the new value. The two plots created by this analysis tool will also be automatically updated (see Figure 148).

---

23 Please refer to the User Manual for more information on the Calculate signal analysis tool.
6.5 – Potential scan FRA data

This analysis tool is intended to be used in combination with data obtained during a Potential scan FRA measurement. These measurements are usually performed using a limited number of frequencies, but at different DC potential values. The Autolab FRA potential scan procedure provides a good example of this type of measurement (see Figure 149).

<table>
<thead>
<tr>
<th>Commands</th>
<th>Parameters</th>
<th>Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRA potential scan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remarks</td>
<td>FRA potential scan: requires FRA module</td>
<td></td>
</tr>
<tr>
<td>End status Autolab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Signal sampler</td>
<td>No signals</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td>1 Options</td>
<td></td>
</tr>
<tr>
<td>Instrument</td>
<td>μ3AUT70530</td>
<td></td>
</tr>
<tr>
<td>Instrument description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Autolab control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set potential</td>
<td>1 200</td>
<td></td>
</tr>
<tr>
<td>Set cell</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Repeated for each value</td>
<td>1, 2, 11, 1, 0.8, 0.8, 0.7, 0.6, 0.5, 0.4, 0.3</td>
<td></td>
</tr>
<tr>
<td>Number of repetitions</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>Parameter link</td>
<td>1, 2</td>
<td></td>
</tr>
<tr>
<td>Set potential</td>
<td>1 200</td>
<td></td>
</tr>
<tr>
<td>Potential (M)</td>
<td>1 200</td>
<td></td>
</tr>
<tr>
<td>Wait time (s)</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>FRA measurement potentiostic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set cell</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Potential scan FRA data</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 149 – Detailed view of the FRA potential scan procedure
The Potential scan FRA data analysis command is already included in the Autolab procedure. This command is automatically executed at the end of the measurement.

To illustrate the use of the Potential scan FRA data analysis tool, the measured data points recorded using the FRA potential scan procedure on the Autolab dummy cell (d) will be used.

The Potential scan FRA data analysis command has been removed from the procedure used in this example.

The data obtained with this procedure is presented as shown in Figure 150 in the Analysis view.

Figure 150 - The data obtained using the FRA potential scan procedure (the measurements are repeated twelve times at DC potential values between 1.2 V and 0.1 V)

To use the Potential scan FRA data in combination with the data obtained during a FRA potential scan measurement, right-click the FRA potential scan header in the data explorer frame and select the Add Analysis – Potential scan FRA data option from the context menu (see Figure 151).
A new item, called Potential scan FRA data, will be added to the data set (see Figure 152).
The Potential scan FRA data tool calculates several useful values from the impedance data obtained at the different DC potential values. These values are required to create the Mott-Schottky plots.

\[ \left( \frac{(-Z''^2 + (Z' - R_s)^2)\omega}{-Z''} \right)^2 \]

Table 5 provides an overview of the additional values calculated by the Potential scan FRA data tool:

<table>
<thead>
<tr>
<th>Value</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angular frequency, ( \omega )</td>
<td>( 2\pi \cdot f )</td>
</tr>
<tr>
<td>Serial resistance, ( R_s )</td>
<td>100</td>
</tr>
<tr>
<td>( \frac{1}{C_s^2} )</td>
<td>((-\omega Z'')^2)</td>
</tr>
<tr>
<td>( \frac{1}{C_p^2} )</td>
<td>( \left( \frac{(-Z''^2 + (Z' - R_s)^2)\omega}{-Z''} \right)^2 )</td>
</tr>
</tbody>
</table>
The values of $C_s$ and $C_p$ are calculated using the value of the Serial resistance, $R_s$. This value is set to 100 by default, but it can be changed by selecting the $R_s$ signal in the list of signals shown in the frame on the right-hand side of the Analysis view and clicking the Edit signal button in the toolbar (see Figure 153).

The calculate signal window will appear$^{24}$. The value of $R_s$ can be adjusted in the Expression field (see Figure 154).

$^{24}$ Please refer to the User Manual for more information on the Calculate signal analysis tool.
Figure 154 – Adjusting the value of the serial resistance, Rs

Press the OK button to validate the change of the Rs value. The value of Cp generated by the Potential scan FRA data analysis tool will be automatically recalculated using the new value.

In order to create the Mott-Schottky plots, one final user-defined parameter is required. Click the Select frequency item in the data explorer frame. A frequency selection table will be displayed on the right-hand side (see Figure 155).
The Potential scan FRA data analysis tool automatically prepares two Mott-Schottky plots (see Figure 156). The Rs-Cs assumes a linear RC equivalent circuit while the Rs-Cp/Rp assumes a R(RC) equivalent circuit.
The data shown in Figure 156 has been obtained by using the *Potential scan FRA data* analysis tool on experimental values obtained with the Autolab dummy cell (d). The equivalent circuit of this dummy cell includes a serial combination of a 5000 Ohm resistance and a 1 µF capacitance. The $R_s$-$C_s$ plot has been created using the calculated data at 100 Hz (see Figure 155).

The value shown in the $R_s$-$C_s$ plot for $1/C_s^2$ is $\sim 1E12$, which is consistent with a capacitance value of 1 µF.

The $R_s$-$C_p/R_p$ plot, obtained using the same parameters, is shown in Figure 157. The values are also consistent with a capacitance value of 1 µF.
The Rs-Cp/Rp Mott-Schottky plot obtained from the data collected on the Autolab dummy cell (d)

6.6 – Export to ZView

It is possible to export impedance data to a ZView\textsuperscript{25} compatible ASCII file for further data analysis. Right-click the impedance measurement and select the Export to ZView option from context menu. Specify a file name in the Save as dialog (see Figure 158).

\textsuperscript{25} ZView is a software package produced by Scribner Associates.

Figure 158 – The Export to ZView option can be used to directly export impedance data to a ZView compatible file
7 – Advanced FRA measurements

This section of the tutorial covers advanced measurement strategies available in NOVA. The software provides a considerable amount of flexibility and a few examples are provided for information. Listing all the possible use cases falls outside of the scope of this tutorial. Feel free to contact your Autolab distributor or nova@metrohm-autolab.com for more information or technical assistance.

7.1 – Single point measurements

Some electrochemical measurements only require the impedance to be measured at a single frequency, without involving a full frequency scan. For this type of measurements, it is possible to use the FRA single frequency command in standalone mode. Figure 159 provides an example of a procedure using the FRA single frequency command to measure the impedance of the cell at 100 Hz, using an amplitude of 0.1 V.

```
Figure 159 – An example of a procedure using the FRA single frequency in stand alone mode
```
NOVA Impedance spectroscopy tutorial

Measurements using the *FRA single frequency* command are identical to measurement performed using a frequency scan. The Options and the FRA sampler can be used to specify automatic current ranging conditions and the signal to record and store during the single frequency measurement.

**Note**

For measurements using the *FRA single frequency* command, the **FRA input** toggle must be enabled before the measurement and disabled after the measurements. This can be done by using the *Autolab control* command, as shown in Figure 159. This toggle can be found in the Advanced section of the Autolab control window (see Figure 160).

![Autolab control window](image)

**Figure 160 – The FRA input toggle can be found in the Autolab control window**

### 7.2 – Measuring an external transfer function

Electrochemical impedance spectroscopy measurements assume that the transfer function of interest is $Z$, which corresponds to the ratio of the AC potential over the AC current (see Section 8). Electrochemical impedance is in fact a specific form of a more general definition of impedance. The AC perturbation can be of a wide range of parameters, such as the rotation rate of a rotating disc electrode (EHD), or the light intensity of a light source (IMVS/IMPS), etc.

Generalized impedance measurements are possible in Nova through the SMB connectors located on the front panel of the FRA32M module or through the BNC
connectors on the front panel of the FRA2 module. To measure external sine waves on both inputs of the FRA module and to measure the generalized impedance, the FRA measurement external command, located in the Measurement – impedance group of commands, must be used.

The FRA measurement external command provides a dedicated editor through which all the parameters required for a frequency scan can be defined. To open this editor, click the button located next to the command in the procedure editor (see Figure 161).

Figure 161 – Opening the parameter editor for the FRA measurement external command

The FRA editor window will be displayed (see Figure 162).

Figure 162 – The FRA editor window

---

26 This option is not available with the µAutolab type III.
The FRA editor displays several sections in the frame the left-hand side.

### 7.2.1 – External

The External section of the FRA editor window is used to specify the parameters for the determination of the external transfer function (see Figure 163).

![FRA editor window](image)

**Figure 163 – The parameters of the external transfer function are defined on the External section**

The external transfer function requires the definition of units and optional multiplier for the \( \leftarrow V \) output of the FRA module and the \( \rightarrow X \) and \( \rightarrow Y \) inputs of the FRA module.

For example, for electrohydrodynamic (EHD) measurements, the modulation generated by the FRA module is applied on the controller of a rotating disc electrode. For the Autolab RDE\(^{27}\), the settings for the FRA \( \leftarrow V \) output would be as shown in Figure 164.

---

\(^{27}\) The V to RPM conversion factor for the Autolab RDE is 1000 RPM/V, or 0.001 V/RPM.
Figure 164 - The settings for the RDE control through the $\leftarrow V$ output of the FRA module

The same parameters can be defined for the $\rightarrow X$ and $\rightarrow Y$ inputs of the FRA, by clicking the $\uparrow$ button to expand the corresponding panel (see Figure 165).

Figure 165 – The parameters for the $\rightarrow X$ input are defined on a dedicated panel

For example, for the EHD measurements, the rotation rate is measured on the $\rightarrow X$ input and the current is measured on the $\rightarrow Y$ input of the FRA. The corresponding settings are shown in Figure 166.
Figure 166 – The settings for the $\rightarrow X$ and $\rightarrow Y$ inputs for a EHD measurement

In the last panel of the External section, the parameters of the transfer function itself can be defined (see Figure 167).
Figure 167 – The parameters of the transfer function

On this panel, the units and symbols as well as the ratio of input signals can be defined.

7.2.2 – Frequency scan

The Frequency scan section of the FRA editor window is used to specify the frequency scan parameters using in the measurement (see Figure 168).

Note

The units shown in the Frequency section depend on the External section.
The following parameters are defined in this section:

- **First applied frequency**: the first frequency of the scan, in Hz.
- **Last applied frequency**: the last frequency of the scan, in Hz.
- **Number of frequencies (per decade)**: the number of frequencies (or frequencies per decade) in the scan.
- **Frequency step**: the distribution of frequencies used in the scan. For impedance spectroscopy measurements, the logarithmic distribution or frequencies per decade are usually the most suitable choice.
- **Amplitude**: the value of the applied amplitude, specified as RMS or TOP value. The TOP amplitude is equal to the RMS amplitude multiplied by $\sqrt{2}$.
- **Wave type**: the modulation type applied during the scan (single sine or multi sine).

More information on multi sine measurements is provided in Section 4.1.10 of this document.

7.2.3 – Sampler

The acquisition parameters used during the frequency scan are specified in the Sample section of the FRA editor. This section is split into two parts, Basic and Advanced (see Figure 169).
The following parameters are defined in the Basic editor:

- **Maximum integration time (0.125 s):** the longest time, in seconds, during which the AC response of the cell is recorded for data analysis. Long integration time values increase the duration of the frequency scan but improve the signal to noise ratio.

- **Minimum integration cycles (1):** defines the minimum cycles of the AC response to record for data analysis (this value overrides the previous parameter at low frequencies). The minimum value is one cycle and the maximum number is 16. Integrating over a large number of cycles increases the duration of the frequency scan but improves the signal to noise ratio. This value must be an integer.

The integration time and **Minimum number of cycles to integrate** define the duration of the data acquisition segment for each FRA single frequency command. These two parameters are competing against one another and depending on the frequency of the applied signal: the measurement duration will be defined by one of these two parameters:

- If the Frequency is larger than \( \frac{1}{\text{Integration time}} \), the acquisition time will be defined by the Integration time parameter.
- If the Frequency is smaller than \( \frac{1}{\text{Integration time}} \), the acquisition time will be defined by the Minimum number of cycles to integrate parameter.

Furthermore, it is possible to specify if additional signals must be sampled or calculated during the measurement. The following settings are available:

- **Sample time domain:** if this option is active, the time domain information will be sampled and stored for the \( \rightarrow X \) and the \( \rightarrow Y \) inputs.
NOVA Impedance spectroscopy tutorial

of the FRA module. The time domain information consists of the raw X and Y sine waves. This information can be used to build a Lissajous plot, or to evaluate the signal to noise ratio and to verify the linearity of the cell response. The Time domain, X (AC) and Y (AC) and X resolution and Y resolution signals are added to the data for each individual frequency when this option is on.

- **Sample frequency domain**: if this option is active, the frequency domain information will be sampled and stored for the X and the Y. The frequency domain information consists of the calculated FFT results obtained from the measured time domain. The frequency domain information can be used to evaluate the measured frequency contributions. The Frequency domain, X frequency domain and Y frequency domain signals are added to the data for each individual frequency when this option is on.

- **Sample DC**: if this option is active, the DC components for both the potential and current will be sampled and stored alongside the impedance data. The Potential (DC) and Current (DC) signals are added to the data for each individual frequency when this option is checked. This option is active by default.

- **Calculate admittance**: if this option is active, the admittance values will be calculated during the measurement (Y’, -Y”).

**Note**

The names defined in the External section of the FRA editor will be used to identify the X and Y signals in the procedure editor.

Additional settings can be specified in the Advanced editor. To toggle the display of the parameter, click the button next to the Advanced label in the editor (see Figure 170).

**Note**

The Advanced settings are predefined to an optimal value for most measurements. Please read the following section of the manual carefully before adjusting these settings.
The following advanced settings can be adjusted, if necessary:

- **Re-jIm or Re+jIm radio button**: this setting defines how the impedance is expressed in terms of its real (Re, or Z') and imaginary (Im or Z'') components. By default, the Re-jIm convention is used. Using this toggle it is possible to acquire impedance data using the alternative convention\(^{28}\).

- **Lowest bandwidth**: defines the lowest bandwidth setting used by the Autolab during the measurement (High stability, High speed and Ultra high speed). In High stability, the bandwidth will automatically be set to High stability for frequencies below 10 kHz and to High speed for frequencies below 100 kHz. The Ultra high speed mode is used for frequencies above 100 kHz. When this parameter is set to High speed, the High stability setting is not used. When this parameter is set to Ultra high speed, only this bandwidth setting is used. High stability is set by default and is recommended for most measurements\(^{29}\).

- **Number of cycles to reach steady state**: the number of cycles to apply in between two consecutive frequencies before resuming data acquisition (0 – 30000 cycles).

- **Maximum time to reach steady state (s)**: the maximum amount of time to wait between two consecutive frequencies before resuming data acquisition (this value overrides the previous setting at low frequencies). The maximum value is 30000 s.

---

\(^{28}\) When the Re+jIm convention is used, the impedance analysis tools provided in Nova cannot be used since these tools assume that the Re-jIm convention is used. In this case, data analysis should be performed using a third party application, like ZView.

\(^{29}\) Please refer to the Getting Started manual for more information on the Autolab bandwidth settings.
**With a minimum fraction of a cycle:** defines the minimal fraction of a cycle to wait before the response can be recorded (overrides the previous setting at very low frequencies). This value can be set between 0 and 1.

The **Number of cycles to reach steady state, Maximum time to reach steady state, with a minimum fraction of a cycle** parameters define the duration of the stabilization segment between two consecutive frequencies. These parameters are competing against one another, and depending on the frequency of the applied signal, the timing will be defined by one of these three parameters:

- If the \((\text{Number of cycles to reach steady state}/\text{Frequency})\) is smaller than \(\text{Maximum time to reach steady state}\), the settling time will be defined by the \(\text{Number of cycles to reach steady state}\) parameter.
- If the \((\text{Number of cycles to reach steady state}/\text{Frequency})\) is larger than \(\text{Maximum time to reach steady state}\), the settling time will be defined by the \(\text{Maximum time to reach steady state}\) parameter.
- For very low frequencies, if \((1/\text{Frequency})\) is larger than the \(\text{Maximum time to reach steady state}\), the settling time will be defined by the **With the minimum fraction of a cycle** parameter.

### 7.2.4 – Plots

The Plots section of the FRA editor window is used to specify which plots should be generated during the measurement (see Figure 171).

![Figure 171 – The Plot parameters](image-url)
The available plots depend on the parameters specified in the Sampler section.

The following plots are available (if the Sampler parameters are adjusted accordingly):

- **Nyquist impedance**: plots the measured $-Z''$ values versus the measured $Z'$ values, using isometric axes.
- **Nyquist admittance**: plots the calculated $-Y''$ values versus the calculated $Y'$ values, using isometric axes.
- **Bode**: plots the phase (in opposed values) and the logarithm of the measured impedance ($Z$), versus the logarithm of the frequency.
- **AC vs t**: plots the raw sinewave amplitudes for the potential and the current signals versus the time.
- **Resolution vs t**: plots the instrumental resolution for the measured potential and current signals versus the time.
- **Lissajous**: plots the raw AC current versus the raw AC potential.

Five locations settings are available using the dedicated buttons, for each plot (see Figure 172).

![FRA editor](image)

*Figure 172 – The plot location can be specified for each plot individually*
For each plot, the location can be set to plot 1, 2, 3 or 4. If the plot should be created but not plotted, the plot location can be set to - (see Figure 173).

Figure 173 – The plot location of the plots (1-4), or not plotted (-)

7.2.5 – Summary

The Summary section of the FRA editor provides a complete summary of the frequency scan parameters defined in the FRA editor (see Figure 174).

Figure 174 – The Summary section of the FRA editor window

Each frequency in the scan is displayed in the table, along with the amplitude values, wave type, minimum integration time and maximum number of cycles to integrate (see Figure 174).
A tooltip displays information about each individual frequency in the scan (see Figure 175).

**Figure 175 – Information on each individual frequency is displayed in a tooltip**

The summary section can be used to fine tune the frequency scan in three different ways:

1. The parameters of one or more frequencies in the table can be adjusted manually (see Section 4.1.6).
2. Additional frequencies can be added manually to the table (see Section 4.1.7).
3. The frequencies can be sorted ascending or descending (see Section 4.1.8).

**Note**

The instructions for fine tuning the frequency scan are the same as for a normal frequency scan.

Clicking the **OK** button validates the frequency scan and closes the editor. The procedure editor will be updated (see Figure 176).
The FRA measurement external command can be used to perform impedance measurements in combination with external devices.

**Warning**

When the *FRA measurement external* command is used, the AC perturbation generated by the FRA module is not internally applied on the Autolab PGSTAT. The AC signal is available on the front panel of the Autolab (V BNC connector on the FRA module).

**Warning**

Default settings of generalized transfer functions for different external devices are available on request. Contact nova@metrohm-autolab.com for more information.
8 – Hardware description

8.1 – FRA32M

The FRA32M consists of a digital signal generator (DSG), a signal conditioning unit (SCU), and a fast analog-to-digital converter with two channels (ADC). A schematic overview of the FRA32M module is provided in Figure 177.

The DSG consists of a large digital memory (RAM), which is loaded with the digital representation of the applied signal and Direct Digital Synthesis (DDS) module which converts this digital representation into the analog equivalent. A variable-gain amplifier (VGA) is used to amplify the generated signal. This architecture ensures accurate signal generation.

The time dependent potential and current signals from the Autolab are filtered and amplified by the signal conditioning unit (SCU) and recorded by means of the ADC. The acquired signals are stored in the digital memory on the FRA32M module. This digital memory allows time domain averaging of up to 4096 repetitive measurement cycles.

Each cycle can consist of 4096 points. This feature provides high accuracy and reproducibility. Since a cycle can consist of 4096 points and a measurement can consist of 4096 repetitive cycles, a single impedance measurement can take 4096 x 4096 A/D-conversions for each channel.

The analysis of the time-domain measurements is done by means of the Fast Fourier Transform (FFT) method. Both the potential signal $E(t)$ and current signal $i(t)$ are transformed into $E(f)$, $i(f)$ and their complex conjugated $E^0(f)$ and $i^0(f)$.
The cell impedance $Z$ is calculated from the equation:

$$Z = \frac{E(f)E^0(f)}{i(f)E^0(f)}$$

The FRA32M-module allows measurements in the range of 10 µHz to 32 MHz. The module can be used in two different modes:

- Single sine: a signal with a single frequency is applied
- Multiple sines: a signal with more than one frequency is applied

Note

In combination with the Autolab PGSTAT, the maximum achievable frequency is 1 MHz despite the higher available limit of the FRA32M.

The single sine mode offers highest accuracy at high frequencies (> 10 Hz). However, at low frequencies, the duration of a complete frequency scan may become a problem. The multiple sines mode provides the opportunity of measuring five frequencies within one frequency decade or even fifteen frequencies within two decades in a single measurement cycle\(^{30}\).

The multi sines mode saves considerable time, allowing measurement of reliable impedance data even when the electrochemical cell exhibits time-dependent behavior. The drawback of this mode is that the accuracy of the measurement is lower compared to the single sine mode.

The RAM of the digital signal generator (DSG) is loaded with the digital representation of the signal to be applied. The 16-bit digital waveform is then fed to the DDS where it is converted into an analog waveform.

The VGA is used to control the amplitude of the output signal of the DSG. The maximum amplitude of the DSG peak-to-peak equals 10 V. Since the signal is divided by ten on the summation point of the Autolab\(^{31}\), the maximum amplitude peak-to-peak equals 1 V. The resolution of the applied signal is better than 0.1 mV.

The output signals of the Autolab, $i$ (current output) and $E$ (potential output), are filtered and amplified using variable-gain amplifiers.

The two-channel simultaneous-sample-and-hold analog-to-digital converters are 14-bits wide. The maximum conversion rate is 800 kHz. The results of the

\(^{30}\) With 5 sines, the following multipliers of the base frequency are used: 1, 3, 5, 7 and 9. With 15 sines, the following multipliers of the base frequency are used: 1, 3, 5, 7, 9, 13, 19, 25, 33, 41, 51, 61, 73, 87 and 99.

\(^{31}\) Refer to the Getting Started for more information.
NOVA Impedance spectroscopy tutorial

conversions are stored in two memories each with 4096 words of 24-bits wide. Thus each memory location can contain the sum of up to 4096 conversions.

8.2 – FRA2

The FRA2 consists of a digital signal generator (DSG), a signal conditioning unit (SCU), and a fast analog-to-digital converter with two channels (ADC). A schematic overview of the FRA2 module is provided in Figure 178.

The DSG consists of a large digital memory (RAM), which is loaded with the digital representation of the applied signal and a fast settling 16-bit digital-to-analog converter (DAC). A multiplying digital-to-analog converter (mDAC) controls the signal amplitude. This architecture ensures accurate signal generation.

The time dependent potential and current signals from the Autolab are filtered and amplified by the signal conditioning unit (SCU) and recorded by means of the ADC. The acquired signals are stored in the digital memory on the FRA2 module. This digital memory allows time domain averaging of up to 4096 repetitive measurement cycles.

Each cycle can consist of 4096 points. This feature provides high accuracy and reproducibility. Since a cycle can consist of 4096 points and a measurement can consist of 4096 repetitive cycles, a single impedance measurement can take 4096 x 4096 A/D-conversions for each channel.

Figure 178 – Schematic overview of the FRA2 module architecture in combination the PGSTAT

The analysis of the time-domain measurements is done by means of the Fast Fourier Transform (FFT) method. Both the potential signal \( E(t) \) and current signal \( i(t) \) are transformed into \( E(f) \), \( i(f) \) and their complex conjugated \( E^0(f) \) and \( i^0(f) \).
The cell impedance $Z$ is calculated from the equation:

$$Z = \frac{E(f) \cdot E^0(f)}{i(f) \cdot E^0(f)}$$

The FRA2-module allows measurements in the range of 10 µHz to 1 MHz. The module can be used in two different modes:

- Single sine: a signal with a single frequency is applied
- Multiple sines: a signal with more than one frequency is applied

The single sine mode offers highest accuracy at high frequencies (> 10 Hz). However, at low frequencies, the duration of a complete frequency scan may become a problem. The multiple sines mode provides the opportunity of measuring five frequencies within one frequency decade or even fifteen frequencies within two decades in a single measurement cycle\(^{32}\).

The multi sines mode saves considerable time, allowing measurement of reliable impedance data even when the electrochemical cell exhibits time-dependent behavior. The drawback of this mode is that the accuracy of the measurement is lower compared to the single sine mode.

The RAM of the digital signal generator (DSG) is loaded with the digital representation of the signal to be applied. The 16-bit digital waveform is then fed to the DAC where it is converted into an analog waveform.

The 12 bit multiplying DAC (mDAC) is used to control the amplitude of the output signal of the DSG. The maximum amplitude of the DSG peak-to-peak equals 10 V. This mDAC makes it possible to set the output of the DSG with a resolution of 1 in 4096. Since the signal is divided by ten on the summation point of the Autolab\(^{33}\), the maximum amplitude peak-to-peak equals 1 V. The resolution of the applied signal is better than 0.1 mV.

The output signals of the Autolab, $i$ (current output) and $E$ (potential output), are filtered and amplified. The two identical amplifiers have software programmable gains of 0.5, 1, 2, 4, 8, 16, 32, 64, 128 and 256. The filter is a programmable 8th order Butterworth low-pass filter.

The two-channel simultaneous-sample-and-hold analog-to-digital converters are 12-bits wide. The maximum conversion rate is 800 kHz. The results of the conversions are stored in two memories each with 4096 words of 24-bits wide. Thus each memory location can contain the sum of up to 4096 conversions.

\(^{32}\) With 5 sines, the following multipliers of the base frequency are used: 1, 3, 5, 7 and 9

\(^{33}\) With 15 sines, the following multipliers of the base frequency are used: 1, 3, 5, 7, 9, 13, 19, 25, 33, 41, 51, 61, 73, 87 and 99.

\(^{33}\) Refer to the Getting Started for more information.
Appendix – Description of the B2 circuit element

The B2 circuit element available in the Fit and Simulation analysis tool is a transmission line element derived from the classical model for a porous or mixed-phase electrode of thickness L (see Figure 179).

\[
Z_{B2} = \frac{X_1 X_2}{X_1 + X_2} \left( L + \frac{2\lambda}{\sinh\left(\frac{L}{\lambda}\right)} \right) + \lambda \frac{X_1^2 + X_2^2}{X_1 + X_2} \coth\left(\frac{L}{\lambda}\right)
\]

Where \( \lambda \) is given by:

\[
\lambda = \sqrt{\frac{X_3}{X_1 + X_2}}
\]